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Warranty
Tektronix warrants that this product will be free from defects in materials and workmanship for a period of three (3) years from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective product
without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and replacement
products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced parts, modules and
products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period and
make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the defective
product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the product to
Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall be responsible
for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care.
Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel other than
Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or connection to
incompatible equipment; c) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product
that has been modified or integrated with other products when the effect of such modification or integration increases the time or difficulty
of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL
NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER
TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Important safety information
This manual contains information and warnings that must be followed by the user for safe operation and to keep the product in a
safe condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary
Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or
any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

This product shall be used in accordance with local and national codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to
the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use. Do not use the
provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the
grounding conductor must be connected to earth ground. Before making connections to the input or output terminals of the
product, ensure that the product is properly grounded. Do not disable the power cord grounding connection.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location. Do not
position the equipment so that it is difficult to operate the power cord; it must remain accessible to the user at all times to allow for
quick disconnection if needed.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected to a voltage
source. Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be
suitable for the product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product
manual for further ratings information before making connections to the product. Do not exceed the Measurement Category
(CAT) rating and voltage or current rating of the lowest rated individual component of a product, probe, or accessory. Use caution
when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Do not float the common terminal above the rated voltage for that terminal.

The measurement terminals on this product are not rated for connection to mains or Category II, III, or IV circuits.
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Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open. Hazardous
voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the
product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use
probes or test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a warm
environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the installation instructions in the manual for details on installing the product so it has
proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into
any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may
result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Use care when lifting and carrying the product. This product is provided with a handle or handles for lifting and carrying.

WARNING. The product is heavy. To reduce the risk of personal injury or damage to the device get help when lifting or carrying
the product.

Use only the Tektronix rackmount hardware specified for this product.

Important safety information  
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Probes and test leads
Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.

Keep fingers behind the protective barrier, protective finger guard, or tactile indicator on the probes.

Remove all probes, test leads and accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and
adapters for any measurement.

Beware of high voltages. Understand the voltage ratings for the probe you are using and do not exceed those ratings. Two
ratings are important to know and understand:

■ The maximum measurement voltage from the probe tip to the probe reference lead

■ The maximum floating voltage from the probe reference lead to earth ground

These two voltage ratings depend on the probe and your application. Refer to the Specifications section of the manual for more
information.

WARNING. To prevent electrical shock, do not exceed the maximum measurement or maximum floating voltage for the
oscilloscope input BNC connector, probe tip, or probe reference lead.

Connect and disconnect properly. Connect the probe output to the measurement product before connecting the probe to the
circuit under test. Connect the probe reference lead to the circuit under test before connecting the probe input. Disconnect the
probe input and the probe reference lead from the circuit under test before disconnecting the probe from the measurement
product.

Connect the probe reference lead to earth ground only.

Inspect the probe and accessories. Before each use, inspect probe and accessories for damage (cuts, tears, or defects in the
probe body, accessories, or cable jacket). Do not use if damaged.

Ground-referenced oscilloscope use. Do not float the reference lead of this probe when using with ground-referenced
oscilloscopes. The reference lead must be connected to earth potential (0 V).

Floating measurement use. Do not float the reference lead of this probe above the rated float voltage.

Service safety summary
The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of rendering
first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains power
before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect power, remove
battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.

Important safety information
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Terms in the manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Terms on the product
These terms may appear on the product:

■ DANGER indicates an injury hazard immediately accessible as you read the marking.

■ WARNING indicates an injury hazard not immediately accessible as you read the marking.

■ CAUTION indicates a hazard to property including the product.

Symbols on the product

When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential
hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbols may appear on the product:

                 

Important safety information  
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Preface
This manual provides product safety and compliance information, describes how to connect and power on the oscilloscope, and
introduces the instrument features, controls and basic operations. See the product Help file for more detailed information.

Key features
Welcome to the 5 Series MSO Low Profile. The 5 Series MSO Low Profile (MSO58LP) is an 8-channel oscilloscope with the
world's first FlexChannel®-based inputs, enabling you to efficiently and cost-effectively perform mixed signal debugging on
virtually any design.

■ Low profile instrument with no display, comes ready to install in a 2U rack mount space

■ 1 GHz bandwidth

■ 8 channels with FlexChannel® inputs

■ Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel
digital probe (the TLP058 FlexChannel Logic Probe)

■ Maximum 6.25 GS/s sample rate

■ 125 M points record length on all channels

■ 500,000 waveforms/second maximum waveform capture rate

■ FastFrame™ segmented memory acquisition uses multiple trigger events to capture widely spaced events of interest at high
sample rates while conserving acquisition memory

■ No set limit on the number of math, reference, and bus waveforms you can acquire (the number of waveforms depends on
available system memory)

■ Integrated options include a 50 MHz arbitrary/function generator (AFG), and a Digital Voltmeter (DVM) and trigger frequency
counter

■ Advanced serial bus triggering and analysis options let you decode and trigger on industry standard buses. See the Serial
bus and trigger options Help topic

■ Power and Jitter options provide additional measurement and analysis functions. See the Advanced Power Analysis and
Advanced Jitter Analysis option Help topics
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Related documents
Use the related documents for more information on instrument functions, how to remotely program or operate the instrument,
understand theory of operation, replace suspected modules, and do other tasks.

MSO58LP documents

To learn about Use this document
How to use instrument
functions

5 Series MSO MSO58LP Installation and Safety Manual (this document, Tektronix part number
071-3568-xx); standard accessory with the instrument. Single document with English,
Japanese, and Simplified Chinese languages. A Russian language version is available to
download from the Tektronix web site (Tektronix part number 077-1404-xx)

5 Series and 6 Series MSO Help (Tektronix part number 077-1303-xx; Printable version of the
instrument Help; available at www.tektronix.com/downloads)

How to remotely control the
instrument

5 Series and 6 Series MSO Programmer Manual (Tektronix part number 077-1305-xx; available
at www.tek.com/downloads)

Instrument specifications and
procedures to verify the
instrument meets
specifications

5 Series MSO MSO54, MSO56, MSO58, MSO58LP Specifications and Performance
Verification Technical Reference (Tektronix part number 077-1306-xx; available at
www.tek.com/downloads)

Using the TLP058 Logic Probe TLP058 FlexChannel® Logic Probe Instructions (Tektronix part number 071-3515-xx; available
at www.tek.com/downloads)

Converting the instrument for
benchtop use

MSO58LP Bench Conversion Kit Instructions (Tektronix part number 075-1102-xx; available at
www.tek.com/downloads)

Preface
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Installing your instrument

Check shipped accessories
Make sure that you received everything you ordered. If anything is missing, contact Tektronix Customer Support. In North
America, call 1-800-833-9200. Worldwide, visit www.tek.com to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all standard accessories and ordered
items. If you purchased factory installed options such as a Serial Bus and Triggering option, or the Power measurements option,
tap Help > About to confirm that the option(s) are listed in the Installed Options table.

MSO58LP standard accessories

Item Quantity Tektronix part number
5 Series MSO MSO58LP Installation and Safety Manual 1 071-3568-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A
Report of factory installed licenses 1 N/A

Operating requirements
Use the oscilloscope within the required operating temperature, power, altitude, and signal input voltage ranges to provide the
most accurate measurements and safe instrument operation.

Environment requirements

Characteristic Description
Operating temperature 0 °C to +50 °C (+32 °F to +122 °F)

 
For proper cooling, keep the sides of the instrument clear of obstructions for 2 inches
(51 mm).

Operating humidity 5% to 90% relative humidity (% RH) up to +40 °C (+104 °F), Noncondensing.
 
5% to 55% RH above +40 °C up to +50 °C (+104 °F to +122 °F), Noncondensing.

Operating altitude Up to 3000 meters (9842 feet)
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Power requirements

Characteristic Description
Power source voltage 100 V - 240 VAC RMS, ±10%, single phase
Power source frequency 50/60 Hz, 100-240 V

 
400 Hz, 115 V

Power consumption All models: 400 W maximum

Input signal requirements
Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and
digital probes or instrument.

Make sure that input signals are within the following requirements.

Input Description
Analog input channels, 1 M Ω setting, maximum
input voltage at BNC

300 VRMS
 
Measurement Category II

Analog input channels, 50 Ω setting, maximum
input voltage at BNC

5 VRMS

Digital input channels, maximum input voltage
range at digital inputs

Observe probe ratings
 
TLP058; ±42 VP

Ref In maximum input voltage at BNC (rear panel) 7 VPP

AUX trigger input ±5 VRMS

Installing the instrument in a rack
Use these instructions to install the MSO58LP into a standard 19" equipment rack.

The MSO58LP comes equipped with the rack bracket hardware installed on the chassis. Use the bolts and washers from the bag
that ships with the instrument to install the rear rack brackets in the rack.

To use an MSO58LP on a bench, purchase and install the MSO58LP Benchtop Conversion kit (Tektronix part number 020-3180-
xx). The kit includes chassis feet and a handle, and lets you stack instruments on a bench.

Follow these steps to install the instrument in a rack:

Installing your instrument  
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WARNING. To prevent injury, two people are required to install the instrument.

1. Use two bolts and washers from the supplied hardware to attach one of the rear rack brackets to the rear of the rack.
Tighten by hand.
 

 

2. Using two people to support the instrument, insert the instrument from the front of the rack so that the chassis rack bracket
inserts into the rear rack bracket.

3. Continue pushing from the front until the instrument is flush with the front of the rack.

4. Use four bolts and washers from the supplied hardware to attach the front of the instrument to the rack. Tighten by hand to
support the instrument.

5. From the rear of the rack, slide the second rear rack bracket onto the instrument chassis rack bracket until the rear rack
bracket is flush with the rear rack.

6. Use two bolts and washers from the supplied hardware to attach the second rear rack bracket to the rear of the rack.
Tighten by hand.

7. Tighten all bolts to 1.1 N·m.

8. Using a 5/16 inch wrench, attach two supplied hexhead bolts to the rack bracket assembly on each side, to lock the
brackets in place and prevent the instrument from unintentional removal when the front rack screws are removed (see the
following image). There are four bolt positions available on each side (see image). Tighten the bracket lock bolts to 0.7 N·m.
 

 

9. Attach power cord and cables to rear chassis as needed.

End of rack mount instructions.

 Installing your instrument
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Secure (lock) the oscilloscope
Lock an oscilloscope to a test bench or equipment rack to prevent property loss.

Attach a standard laptop security lock to the rear panel of the oscilloscope, to secure the oscilloscope to a workbench, rack, or
other location.
 

Powering the oscilloscope
Use this procedure to connect the oscilloscope to line power and power on and off the oscilloscope. Always connect the
oscilloscope to AC power using the power cord that shipped with the instrument.

Prerequisite: Use the AC power cord that shipped with your oscilloscope.

1. Connect the supplied power cord to the oscilloscope power connector.

Figure 1: MSO58LP power cord connector and power standby switch

2. Connect the power cord to an appropriate AC mains source.
Power is supplied to the power supply and some other boards whenever the AC power cord is connected to a live mains
circuit, putting the instrument in standby mode.

3. Push the front panel power button to power the instrument on and off.
The power button color indicates instrument power states:

Unlit – no AC power applied

Yellow – standby mode

Blue – powered on

4. To completely remove power from the instrument, disconnect the power cord.

Installing your instrument 
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Check that oscilloscope passes power-on self tests
Power-on self tests verify that all oscilloscope modules are working correctly after power up.

Prerequisite: For the MSO58LP, connect a monitor to a video output on the rear panel and connect a mouse to a USB port.

1. Power on the oscilloscope and wait until the oscilloscope screen appears.

2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.

3. Check that the status of all power-on self tests are Passed.

If one or more power-on self tests shows Failed:

a. Power cycle the oscilloscope.

b. Tap Utility > Self Test. If one or more power-on self tests still shows Failed, contact Tektronix Customer Support.

Connecting Probes
Probes and cables connect the oscilloscope to your device under test (DUT). Use a probe that best matches your signal
measurement needs.

 
Figure 2: Connecting probes to the MSO58LP

Connect TPP0500B, TPP1000, TekVPI+, TekVPI, or other supported Tektronix analog probes by pushing them into a
FlexChannel connector. The probe base latch locks with a 'click' when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If
a probe has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active
probes to set their parameters (auto zero, degauss, and so on).

 Installing your instrument

MSO58LP Installation and Safety Manual 5



To connect a TLP058 FlexChannel Logic Probe or a TDP7700 Series TriMode™ Probe:

1. Move the locking lever to the unlocked position, then let go to reset locking lever to the center position.

2. Insert the probe into a FlexChannel connector until fully seated and the lock mechanism clicks.

3. Move the locking lever to the locked position. The status light should be a solid green.

4. To disconnect the TLP058 probe, move and hold the locking lever at the unlocked position and pull out the probe. Do not
pull on the ribbon cable while removing the probe.

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until
it locks.

NOTE. Connecting a probe does not automatically enable that channel (make it active). Use the instrument controls or
programmatic interface to turn on a channel and open its configuration menu to verify or change probe or cable settings
(bandwidth, attenuation, termination and so on).

Installing your instrument  
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Getting acquainted with your instrument

MSO58LP front panel controls and connections
The front panel is where you power on or off the instrument, connect signals with probes or cables, connect an external trigger
input signal, insert USB devices, and access a probe compensation signal.
 

 

1. FlexChannel® probe connectors:

FlexChannel® connectors support all TekVPI+ and TekVPI measurement probes, BNC passive probes, the TLP058
FlexChannel® Logic Probe, and BNC cables. You connect most probes simply by pushing them into the connector until the
probe seats with a click. See Connecting Probes on page 5

2. LAN Status LED:

Shows the network connection and activity status:

■ Off - No power to instrument
■ Green - Network connection is good
■ Red - Network connection has fault or is not connected
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3. Probe Compensation connectors:
 

 

The Probe Compensation connections provide a ground connector and 1 kHz square wave source for adjusting the high-
frequency response of a passive probe (probe compensation). The oscilloscope uses this signal to automatically
compensate supported probes. See Compensate the TPP0500B or TPP1000 probes on page 13.

You can also use the ground connector to attach an anti-static wrist strap, to reduce the chance of electrostatic damage
(ESD) while you handle or probe the DUT.

4. USB Host ports:

USB ports are located at the lower right corner of the front panel. Connect USB flash drives to which you can save or recall
data (such as instrument firmware updates, waveforms, settings, and screen captures), or connect peripheral devices such
as a mouse or keyboard.

5. Aux Trig trigger input connector:

An SMA connector to which you can connect an external trigger input signal. Use the AUX In trigger signal with the Edge
trigger mode.

6. Acq status LED:

Shows the instrument trigger/acquisition status:

■ Green - Triggered
■ Yellow - Armed but not yet triggered
■ Red - Acquisition stopped

7. Power On/Standby button:

Powers the instrument on and off. The power button color indicates instrument power states:

■ No light - No AC power applied
■ Yellow - Standby mode
■ Blue - Powered on

Getting acquainted with your instrument  
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Rear panel connections
The rear panel connections supply power to the oscilloscope and provide connectors for network, USB devices, video, reference
signals, and the AFG output.
 

1. Power cord connector. Use only the power cord specified for this product and certified for the country of use.

2. Ref In lets you connect a high-precision 10 MHz reference signal to the oscilloscope for more accurate measurements.

3. AUX Out generates a signal transition on a trigger event, outputs a 10 MHz reference signal, or outputs a synchronization
signal from the AFG.

4. AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.

5. Video outputs (Display Port, VGA, and DVI-D) let you connect an external monitor or projector to show the oscilloscope
screen.

6. USB Device port lets you connect to a PC to remotely control the oscilloscope using USBTMC protocol.

7. USB Host ports let you connect a USB memory device, keyboard, or mouse.

8. LAN connector (RJ-45) connects the oscilloscope to a 10/100/1000 Base-T local area network.

9. Security lock connector lets you use a standard PC/laptop lock cable to secure the oscilloscope to a work bench or other
location.

The graphical user interface
Although designed for programmatic control, the MSO58LP also has a graphical user interface that incorporates product Help
topics. You can access the graphical interface by connecting a monitor and mouse to the instrument, or by using a browser to
access a network-connected instrument.

Connect a monitor (standard or touchscreen) with a minimum resolution of 1,920 horizontal × 1,080 vertical pixels (High
Definition) to a video out connector on the rear panel.

To access from a browser, type the IP address of the instrument in the browser address field to open the instrument's browser
welcome page. Click the Instrument Control (e*Scope®) link on the left of the screen to open the graphical interface.

Connect a mouse (USB cable) or mouse dongle (for USB wireless mouse) to any USB port.

Refer to the 5 Series MSO (MSO54, MSO56, MSO58) Installation and Safety Manual (Tektronix part number 071-3514-xx),
available to download from www.tek.com/product-support, for details on understanding and using the graphical user interface.

Getting acquainted with your instrument
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Configure the instrument

Set the time zone and clock readout format
Set the time zone to your region so that saved files are marked with the correct date and time information. You can also set the
time format (12 or 24 hour clock).

To access the user interface on the MSO58LP, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also
remotely access the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set this control or run this task on an MSO58LP, see the oscilloscope Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.
 

 

2. To turn off showing the date and time on the screen, tap the Display button to Off.
To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the
configuration menu, and set the Display button to On.

3. Select a time format (12 Hour or 24 Hour).

4. Tap the Time Zone field and select the time zone that applies to your location.

5. Tap anywhere outside of the menu to close it.

Download and install the latest firmware
Installing the latest firmware helps ensure that your oscilloscope is taking the most accurate measurements.

To access the user interface on the MSO58LP, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also
remotely access the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.
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Update oscilloscope firmware from a USB drive
Prerequisite: Determine the current version of firmware installed on the oscilloscope (Help > About)

1. Open up a Web browser on a PC and go to www.tek.com/product-support.

2. Enter the oscilloscope model number in the search field and click Go.

3. Scroll down the screen and click the Software tab.

4. If the listed available firmware version (Windows or non-Windows) is newer than what is on your oscilloscope, select and
download that file to your PC.

5. Follow the installation instructions that came with the downloaded firmware to create a firmware install file.

6. Copy the firmware install file to a USB drive.

7. Insert the USB drive into any oscilloscope USB Host port:

a. Non-Windows oscilloscopes detect the USB drive with the firmware file and start the installation process. Follow on-
screen instructions to install the firmware.

b. For Windows oscilloscopes, close the TekScope program before updating the firmware. Open the File Explorer and run
the firmware update file from the USB drive, or copy the firmware update file to the desktop and run the file from there.
Follow on-screen instructions to install the firmware.

NOTE. Do not power off the oscilloscope or remove the USB flash drive until the oscilloscope finishes installing the
firmware. The oscilloscope displays a message when it is OK to turn off the oscilloscope.

8. When the firmware install is finished, remove the USB drive and restart the oscilloscope.
To confirm the firmware installation:

a. Tap Help > About in the Menu bar.

b. Verify that the firmware version number listed on the screen is the same version that you downloaded.

Run Signal Path Compensation (SPC)
Run SPC at regular intervals for best measurement accuracy. You should run SPC whenever the ambient (room) temperature
has changed by more than 5 °C (9 °F), or once a week if you use vertical scale settings of 5 mV per division or less.

To access the user interface on the MSO58LP, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also
remotely access the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set this control or run this task on an MSO58LP, see the oscilloscope Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path, caused by temperature variations
and/or long-term signal path drift. Failure to run SPC on a regular basis may result in the oscilloscope not meeting warranted
performance levels at low volts per division settings.

Prerequisite: Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

1. Power on and warm up the oscilloscope for at least 20 minutes.

2. Tap Utility > Calibration.

Configure the instrument  
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3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take several minutes per channel
to run, so wait until the SPC Status message changes to Pass before reconnecting probes and using the oscilloscope.

CAUTION. You can abort the SPC calibration by tapping Abort SPC. This may leave some channels uncompensated,
resulting in possible inaccurate measurements. If you do abort the SPC, make sure to run the SPC procedure completely
before using the instrument to take measurements.

4. Close the Calibration configuration dialog when SPC has completed.

5. If the SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run the SPC
again. If the SPC still fails, contact Tektronix Customer Support.

Compensate the TPP0500B or TPP1000 probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for an unlimited number of probe/channel combinations.

To access the user interface on the MSO58LP, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also
remotely access the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set this control or run this task on an MSO58LP, see the oscilloscope Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

The oscilloscope stores the compensation values for each probe/channel combination, and automatically recalls the
compensation values when you plug in the probe. Probe compensation status is shown in the Probe Setup panel of the Channel
configuration menu.

■ If the Probe Compensation Status field displays Pass, the probe is compensated and ready for use.

■ If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have
this probe compensation procedure run.

■ If the Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure.
Reconnect the probe and run probe compensation again.

■ If there is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for
that probe. See the oscilloscope Help for how to manually compensate passive probes not supported by the probe
compensation function.

Use this procedure to compensate a TPP0500B, TPP1000, or other supported TPP-family probe that shows a Default status
when connected to the oscilloscope.

NOTE. A Default Setup does not delete probe compensation values. A factory calibration deletes all stored probe compensation
values.

 Configure the instrument
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Prerequisite: The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

1. Connect a supported probe to an input channel.

2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals on the lower right of the oscilloscope
(see following image).

Figure 3: Probe Comp connections on the MSO58LP.

Connect the probe tip to the 1 kHz source, and the ground clip to the ground. For best results, remove any probe tip
accessories and hold the probe tip directly onto the 1 kHz connector.

NOTE. Connect only one probe at a time to the PROBE COMP terminals.

3. Turn off all channels.

4. Turn on the channel to which the probe is connected.

5. On the MSO58LP, select File > Autoset from the menu bar. The screen displays a square wave.

6. Double-tap the badge of the channel that you want to compensate.

7. Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe
to another channel and start again from step 1, or connect a different probe to this channel and start from step 1.

If the Probe Compensation Status says Default, continue with this procedure.

8. Tap Compensate Probe to open the Probe Compensation dialog.

9. Tap Compensate Probe to run the probe compensation.

10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and
ground from the PROBE COMP terminals.

11. Repeat these steps for each supported passive probe that you want to compensate for this channel.

12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

NOTE. For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.

Configure the instrument 
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Connect to a network (LAN)
Connecting to a network allows you to remotely access the instrument.

To access the user interface on the MSO58LP, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also
remotely access the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP
address, Subnet Mask, DNS IP address, and so on).

1. Connect a CAT5 cable from the oscilloscope LAN connector to your network.

2. Select Utility > I/O on the menu bar to open the I/O configuration menu.

3. Obtain or enter the network address information:

■ If your network is DHCP-enabled, and the IP address field does not already show and address, tap Auto to obtain the
IP address information from the network. DHCP mode is the default mode.

■ If your network is not DHCP-enabled, or you need a permanent (non-changing) IP address for this instrument, tap
Manual and enter the IP address and other values provided by your IT or system administrator resource.

4. Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the
instrument successfully connects to your network. If you have problems connecting to your network, contact your system
administration resource for help.
The front panel LAN status LED colors on the MSO58LP display the network status:

■ Off - No power to instrument
■ Green - Network connection is good
■ Red - Network connection has fault or is not connected

Remote access from a Web browser
You can remotely access your network-connected standard instrument (not running Windows 10) from a Web browser to display
the instrument user interface on a PC.

This procedure describes how to remotely access the UI controls and screen for standard (non Windows 10) instruments. To
remotely access the UI controls and screen for Windows 10 instruments, see

Prerequisites:

■ The oscilloscope must be connected to, and accessible from, the network to which the PC is connected. See Connect to a
network (LAN) on page 15

■ The IP address of the oscilloscope that you want to access. To determine the oscilloscope's IP address, select Utility > IO
in the oscilloscope menu bar and view the network settings in the LAN panel.

■ You are accessing a standard (instrument that does not have the Windows OS option installed).

1. Open a Web browser on a PC connected to the same network as the oscilloscope.

2. Enter just the oscilloscope IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The
browser searches for and opens the Web page for the oscilloscope.

 Configure the instrument
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3. Select Instrument Control (e*Scope®). The browser displays the instrument screen.

4. Use a mouse to select and interact with the oscilloscope controls shown in the Web browser. If your remote PC or laptop
has a touch screen monitor, you can use that to access the oscilloscope controls.

NOTE. When you access the instrument from an e*Scope browser, you cannot directly paste text (such as path, IP address
information, and so on) from the PC to an instrument menu field. You must use an intermediate clipboard function that is
available in the e*Scope application.

Use the following steps to copy text from an e*Scope-connected PC to the instrument:

a. Open a connection to the instrument using e*Scope.

b. Select and copy the text on your PC.

c. In e*Scope, press Ctrl-Alt-Shift to open the Clipboard menu.

d. Paste the text into the Clipboard field.

e. Press Ctrl-Alt-Shift to close the browser Clipboard menu

f. Use e*Scope to open the instrument menu to which to paste content, and position the cursor in the field where you
want to paste the text.

g. Press Ctrl-V (on real keyboard or from virtual keyboard) to paste the text from the e*Scope browser clipboard to the
menu field.

h. Repeat steps  4.b through  4.g to copy and paste other text from the PC to the instrument.

Configure the instrument 
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Operating basics
Refer to the 5 Series MSO (MSO54, MSO56, MSO58) Installation and Safety Manual (Tektronix part number 071-3514-xx), for
details on understanding and using the graphical user interface to trigger on and acquire waveforms and take measurements.

Refer to the 5 Series MSO MSO54, MSO56, MSO58, MSO58LP Programmer Manual (Tektronix part number 077-1305-xx) for
the correct command or commands to use to remotely operate the instrument.

Both manuals are available to download from www.tek.com/product-support.
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Maintenance
This section contains information needed to perform periodic maintenance on the instrument.

CAUTION. Do not remove the top cover from the instrument except to replace a damaged cover. There are no user replaceable
parts inside the instrument. Return the instrument to Tektronix if it requires service.

Cleaning
Use a dry, soft cotton cloth to clean the outside of the unit. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl
alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do not use any liquid cleaning agents or
chemicals that could damage the case, controls, markings or labels, or possibly infiltrate the case.

Performance verification interval and adjustment
The voltage and timing references inside the instrument are very stable over time and do not need routine adjustment.

If periodic calibration is one of your organization's requirements, a general rule is to verify performance every 2000 hours of
operation or once a year if the instrument is used infrequently. Use the procedures in the instrument Specifications and
Performance Verification manual, available online at www.www.tek.com/product-support.

If the instrument fails the performance tests in the Specifications and Performance Verification manual, adjustment may be
required. Adjustment can only be performed by a Tektronix Service Center. See Contacting Tektronix, following the title page in
this manual, for information on contacting Tektronix Service Support.

Replaceable parts list
This section contains replaceable parts information for your instrument. Use the lists in the appropriate section to identify and
order replacement parts for your product. 

Standard accessories
Standard accessories for these products are listed near the beginning of this manual.

Replaceable parts
The following figure shows the user-replaceable parts for the MSO58LP. There are no user-replaceable parts inside the
instrument.
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Figure 4: Replaceable parts diagram
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Table 1: Replaceable parts list

Index
number

Tektronix part number Qty Name & description

1 407-6088-xx 2 BRACKET, FRONT, RACK MOUNT, 2U EAR
2 211-1682-xx 14 SCREW, 10-32 X 5/16 BUTTON HEAD, CAP, BLACK
3 407-6089-xx 2 BRACKET, REAR, RACK MOUNT, CHASSIS-SIDE
4 407-6090-xx 2 BRACKET, REAR, RACK MOUNT, RACK-SIDE
5 020-3180-xx 1 BENCH CONVERSION KIT (optional accessory)
Not shown:

A0 1 North America power plug (115 V, 60 Hz)
A1 1 Universal Euro power plug (220 V, 50 Hz)
A2 1 United Kingdom power plug (240 V, 50 Hz)
A3 1 Australia power plug (240 V, 50 Hz)
A5 1 Switzerland power plug (220 V, 50 Hz)
A6 1 Japan power plug (100 V, 50/60 Hz)
A10 1 China power plug (50 Hz)
A11 1 India power plug (50 Hz)
A12 1 Brazil power plug (60 Hz)

Maintenance
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EMC, safety and environmental compliance

Compliance Information
This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies. This product is intended for use by professionals and trained personnel only; it is not designed for use in households or
by children.

Questions about the following compliance information may be directed to the following address:

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC compliance

EU EMC Directive
Meets intent of Directive 2014/30/EU for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1, EN 61326-2-1. EMC requirements for electrical equipment for measurement, control, and laboratory use.  1 2 3 4

■ CISPR 11. Radiated and conducted emissions, Group 1, Class A

■ IEC 61000-4-2. Electrostatic discharge immunity

■ IEC 61000-4-3. RF electromagnetic field immunity  5

■ IEC 61000-4-4. Electrical fast transient / burst immunity

■ IEC 61000-4-5. Power line surge immunity

■ IEC 61000-4-6. Conducted RF immunity

■ IEC 61000-4-11. Voltage dips and interruptions immunity

EN 61000-3-2. AC power line harmonic emissions

EN 61000-3-3. Voltage changes, fluctuations, and flicker

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 Equipment may not meet the immunity requirements of applicable listed standards when test leads and/or test probes are connected due to coupling of electromagnetic

interference onto those leads/probes. To minimize the influence of electromagnetic interference, minimize the loop area between the unshielded portions of signal and
associated return leads, and keep leads as far away as possible from electromagnetic disturbance sources. Twisting unshielded test leads together is an effective way to
reduce loop area. For probes, keep the ground return lead as short as possible and close to the probe body. Some probes have accessory probe tip adapters to
accomplish this most effectively. In all cases, observe all safety instructions for the probes or leads used.

4 For compliance with the EMC standards listed here, high quality shielded interface cables that incorporate low impedance connection between the cable shield and the
connector shell should be used.

5 10 mV/division to 1 V/division: <=0.1 division waveform displacement or <=0.2 division increase in peak-to-peak noise is allowed when the instrument is subjected to
fields and signals as defined in the IEC 61000-4-3.
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EMC Compliance
Meets the intent of Directive 2014/30/EU for Electromagnetic Compatibility when it is used with the product(s) stated in the
specifications table. Refer to the EMC specification published for the stated products. May not meet the intent of the directive if
used with other products.

Australia / New Zealand Declaration of Conformity – EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

■ EN 61326-1 and EN 61326-2-1. Radiated and conducted emissions, Group 1, Class A.

Safety compliance
This section lists the safety standards with which the product complies and other safety compliance information.

EU declaration of conformity – low voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:

Low Voltage Directive 2014/35/EU.

■ EN 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General
Requirements.

■ EN 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

U.S. nationally recognized testing laboratory listing
■ UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General

Requirements.

■ UL 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

Canadian certification
■ CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use

– Part 1: General Requirements.

■ CAN/CSA-C22.2 No. 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory
Use – Part 2-030: Particular requirements for testing and measuring circuits.

Additional compliances
■ IEC 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1:

General Requirements.

■ IEC 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part
2-030: Particular requirements for testing and measuring circuits.

Equipment type
Test and measuring equipment.

EMC, safety and environmental compliance  
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Safety class
Class I -- grounded product.

Pollution degree description
A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment for
which they are rated.

■ Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

■ Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is caused
by condensation must be expected. This location is a typical office/home environment. Temporary condensation occurs only
when the product is out of service.

■ Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

■ Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical outdoor
locations.

Pollution degree rating
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor, dry location use only.

IP rating
IP20 (as defined in IEC 60529).

Measurement and overvoltage category descriptions
Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following categories
(see specific ratings marked on the product and in the manual).

■ Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.

■ Measurement Category III. For measurements performed in the building installation.

■ Measurement Category IV. For measurements performed at the source of low-voltage installation.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating
Overvoltage Category II (as defined in IEC 61010-1)

Environmental compliance
This section provides information about the environmental impact of the product.

EMC, safety and environmental compliance
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Restriction of hazardous substances
Complies with RoHS2 Directive 2011/65/EU.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life.
To avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to
Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Battery recycling
This product contains a small installed lithium metal button cell. Please properly dispose of or recycle the cell at its end of life
according to local government regulations.

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state of California, CR
lithium batteries are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Transporting batteries
The small lithium primary button cell contained in this equipment does not exceed 1 gram of lithium metal content per cell, and
the cell type has been shown by the manufacturer to comply with the applicable requirements of the UN Manual of Tests and
Criteria Part III, Sub-section 38.3. Consult your carrier to determine which lithium battery transportation requirements are
applicable to your configuration, including to its re-packaging and re-labeling, prior to reshipment of the product by any mode of
transport

EMC, safety and environmental compliance  
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Index
A
ACQ acquisition status LED, 7
AFG Out (rear panel), 9
automatic probe compensation (TPP0500B, TPP1000), 13
AUX Out (rear panel), 9
Aux Trig trigger input, 7

C
cable lock, 9
clock format (12/24 hr), how to set, 11
compensate TPP0500B, TPP1000 probes, 13
connect lock cable, 4
connect to a network, 15
connecting probes, 5

D
Display Port video output (rear panel), 9
DVI video output (rear panel), 9

E
e*Scope, 15
Environment requirements, 1, 2
Ethernet port (rear panel), 9
Ethernet, connect to, 15

F
firmware, how to update, 11, 12
FlexChannel inputs, 7
front panel controls, 7

H
how to

check power-on self tests results, 5
compensate TPP0500B, TPP1000 probes, 13
connect probes, 5
connect to network, 15
download, install firmware, 11, 12

remote access the oscilloscope (from Web), 15
run signal path compensation (SPC), 12
set clock format (12/24 hr), 11
set time zone, 11
update firmware, 11, 12

I
input signal level requirements, 2

L
LAN port (rear panel), 9
LAN status LEDs, 7
LAN, connect to, 15
lock to bench or rack, 4

M
Maintenance

replaceable parts, 19

N
network, connect to, 15

O
operating

altitude range, 1, 2
humidity range, 1, 2
temperature range, 1, 2

operating power requirements, 1, 2

P
power cord connector (rear panel), 9
power cords, 19
power requirements, 1, 2
power standby mode, 4
power-on test results, 5
powering on or off, 4
probe comp connectors, 7
probe compensation (TPP0500B, TPP1000), 13
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probes, connecting, 5

R
rear panel

AFG Out, 9
AUX Out, 9
cable lock, 9
Display Port video output, 9
DVI video output, 9
Ethernet port (RJ-45), 9
LAN port (RJ-45), 9
power cord, 9
security cable lock, 9
USB Device port, 9
USB Host ports, 9
VGA video output, 9
video outputs, 9

rear panel connections, 9
Ref In, 9
Ref In (rear panel), 9
remote access (e*Scope), 15
remote access (Web-based), 15
remove AC power from instrument, 4
Replaceable parts, 19
requirements

altitude, 1, 2
environment, 1, 2
humidity, 1, 2

power, 1, 2
signal inputs, 2
temperature, 1, 2

run signal path compensation, 12

S
security cable lock, 9
set

clock format (12/24 hr), 11
time zone, 11

signal input levels, 2
SPC (signal path compensation), 12
standard accessories, 1

T
time zone, how to set, 11
turn instrument on or off, 4

U
USB Device port (rear panel), 9
USB Host ports (rear panel), 9

V
VGA video output (rear panel), 9
video outputs (rear panel), 9
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Ïü~所x国x\一国内{あ»場合{�1当社|}~返送¿用²負担�»�~x�~�2N記ñ外~場所{返送�¼»
製品{tいv�1�yv~~送¿用1関税1税1z¸s}~à~¿用²支払う責任�zû様|負う�~x�~�2

製品~O適Wz使用~��整備ù検~O足{¸sv生��k陥1 害1~��損傷�1本保証~対象外w�2当社�1
aĀ当社担当者ñ外~者{¸»本製品~設置1修理~��整備~実施{¹生��損傷{対�»修理1bĀO適Wz使用~
��互換性~zい機器x~接続{¹生��損傷{対�»修理1cĀ当社製ñ外~Å÷ù´用品~使用{¸º生��損傷~
��動作O良{対�»修理2dĀ本製品|改造~��à~製品x統合�¼�場合{zいv1{{»改造~��統合~影
響{¸º当ü本製品~整備~時間~��÷易度|増加��場合~当ü本製品{対�»整備{tいv�1本保証{基u
�ÅüóÉ²提供�»義務²負わzい�~x�~�2

本保証�1明示wあ»{黙示wあ»{²問わ�à~あ¹ゆ»保証~ïわº{1本製品{関�v当社|zû様{対�v提
供�»�~w�2ö¿øýû¿Éz¸s}~販売店�1商品性~��特Û目的{対�»適合性{tいv~一W~黙示保
証²否認�~�2O具合~あ»製品²修理~��交換�»xいう当社~責任行ú�1本保証~義務違ß{対�vzû様
{提供�¼»唯一~救n手段w�2当社z¸s当社ï理店�1間接的1限Û的1偶~的1~��派生的z損害{tいv
�1{{»損害~ÿ能性²事前{通知�¼vい�{否{{{{わ¹�1一W責任²負わzい�~x�~�2
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Ü全性{関�»重要z情報

�~þûą²û{�1操作²行うĆüÆ~Ü全²確保�1製品²Ü全z状態{保t��{�Û�z�¼ばz¹z
い情報z¸s警告|記載�¼vい~�2

本機~ù検{あ�sv�<Ü全{�使用い�����{={続�<Ü全{保Ûù検�vい�����{=²参照�

v1事故防k{tx�v���い2

Ü全{�使用い�����{

製品�指Û�¼�方法w~��使用���い2人体x~損傷²避�1本製品や本製品{接続�¼vい»製品~
破損²防k�»��{1Ü全性{関�»l~注意事�²¸�z¯����い2�yv~指示事�²注意深�z¯
����い2必要zx}{参照w}»¸う{1®明書²Ü全z場所{保管�vzいv���い2

本製品�ü当�»地域~条例や国内法ð{従sv使用�z�¼ばzº~�³2

本製品²l��Ü全{�使用{z»{�1�~þûą²û{記載�¼�注意事�{従う��wz�1一般{認�¹
¼vい»Ü全対策²徹底�vz�必要|あº~�2

本製品�訓練²Ø��^門知識~あ»ĆüÆ{¸»使用²想Û�vい~�2

製品~»Āü²×º外�v修理や保Û1~��調整²実施w}»~�1あ¹ゆ»t険性²認識��^門的知識~
あ»適格者~�{限Û�»必要|あº~�2

使用前{1既知~情報源x十V{照¹�合わ�v1製品|l��動作�vい»�x²常{Ñ·ó¿�v���い2

本製品�t険電w~検出用{��利用{z¼~�³2

t険z通電^体|露出�vい»部Vw�1感電や²ü¿ûõùóÇą{¸sv�|²�»z}¼|あº~�~w1
保護具²使用�v���い2

本製品²�使用~�{1¸º大}zà~ÇÉöĀ{²¿ËÉ�z�¼ばz¹zい場合|あº~�2à~ÇÉöĀ~
操作{関�»警告や注意事�{tいv�1}~製品Ãンýüýンø~þûą²û{あ»Ü全{関�»Ë¿Çćン
²z¯����い2

本機器²ÇÉöĀ~一部x�v�使用{z»場合{�1}~ÇÉöĀ~構築者|Ü全性{関�»責任²果��
z�¼ばzº~�³2

火災や人体x~損傷²避�»{�

適Wz電源Ãüù²使用�v���い： 本製品用{指Û�¼1使用�¼»国w認Û�¼�電源Ãüù~�²使用�
v���い2à~製品~電源Ãüù�使用�zいw���い2

本製品²接地�v���い： 本製品�1電源Ãüù~Àùンù線²使用�v接地�~�2感電²避�»��1Àùン
ù線²²üÉ{接続�»必要|あº~�2本製品~入出力端子{接続�»前{1製品|l��接地�¼vい»�
x²確認�v���い2電源Ãüù~Àùンù接続²無効{�zいw���い2

電源²W断�v���い： 電源Ãüù~×º外�{¸sv主電源|遮断�¼~�2É´óÑ~O置{tいv�1使
用®明書²参照�v���い2電源Ãüù~×º扱い|困÷z場所{�設置�zいw���い2必要{応�v��
{電源²遮断w}»¸う{1ĆüÆ|常{²¿ËÉw}»状態{�vz�必要|あº~�2

接続xW断~手�²Ûsv���い： ÷ýüöxöÉøûúüù|電w源{接続�¼vい»間�接続~��W断�
zいw���い2絶縁型~電w÷ýüö1öÉøûúüù1z¸s²Ð÷Ï�1製品{付属�»製品{1~��当社
{¸º特w{指Û�¼�製品~�²使用�v���い2
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�yv~端子~Û格{従sv���い： ~火や感電~t険²避�»��{1本製品~�yv~Û格xþü½ン
À{従sv���い2本製品{電源²接続�»前{1Û格~ý細{tいv1製品þûą²û²参照�v���い2
測Û»öÄúÿCATĀ~Û格z¸s電wx電流~Û格{tいv�1製品1÷ýüö1~��²¿ËÅú~う�wĀ�
PいÛ格²超えzい¸う{使用�v���い21：1~öÉøûúüù²使用�»x}�1÷ýüöûÑó÷~電w|直
接製品{伝わ»��注意|必要w�2

ÃĂン端子²含�い{z»端子{�1}~端子~Ā大Û格²超え»電w²{�zいw���い2

端子~Û格電w²超えvÃĂン端子²õýüö³ンÀ��zいw���い2

本製品~測Û端子�1AC電源1»öÄú II1III1z¸s IV回路{�使用w}~�³2

»Āü²外��状態w�使用�zいw���い： »Āüやāýû²外��状態やÁüÉ²開い�~~動作��zい
w���い2t険性~高い電w{接触�v�~うÿ能性|あº~�2

露出��回路x~接触�避�v���い： 電源|投入�¼vい»x}{1露出��接続部VやÃンýüýンø{触
¼zいw���い2

故 ~疑い|あ»x}�使用�zいw���い： 本製品{故 ~疑い|あ»場合{�1資格~あ»ÅüóÉ担当
者{検査²依¼�v���い2

製品|故 �vい»場合{�1使用²停k�v���い2製品|故 �vい»場合やl常{動作�vいzい場合

{�1製品²使用�zいw���い2Ü全N~問題|疑わ¼»場合{�1電源²Wsv電源Ãüù²×º外�v�
��い2誤sv使用�¼»�x|zい¸う{1問題~あ»製品²区w�vzいv���い2

使用前{1電w÷ýüö1öÉøûúüù1z¸s²¿ËÅú{機ø的損傷|zい{²検査�1故 �vい»場合{

�交換�v���い2金属部|露出�vい�º1摩耗´ンÈÁüÏ|見えvい»zy1損傷|見¹¼»÷ýüö~
��öÉøûúüù�使用�zいw���い2

使用�»前{1製品~外観{変W|zい{¸�注意�v���い2rs割¼やk落��部品|zい�x²確認�v

���い2

指Û�¼�交換部品~�²使用�»¸う{�v���い2

�気~多いx�½w�動作��zいw���い： 機器²寒い場所{¹暖{い場所{移動�»�{�1結露{�注
意���い2

爆~性~¼É|あ»場所w�使用�zいw���い：

製品~表面²清潔w乾燥��状態{保sv���い： 製品~清掃²開始�»前{1入力信号²×º外�v���
い2

適W{通気�v���い： 適Wz通気|得¹¼»¸う{製品²設置w}»¸う{1þûą²û~設置手�²参照�
v���い2

製品{�通気用~Éýóøや開口部|あº~�2}~部V²覆s�º1通気|妨�¹¼�º�»�x|zい¸う{

�v���い2開口部{�異物²入¼zいw���い2

Ü全z作業環境²確保�v���い： 製品�常{÷³É÷ü´や´ンÈÁüÏ|¸�見え»場所{設置�v���
い2

½üüüùやý´ンÏ1üÏンûāóù²O適W{使用��º1長�押��~�º�zいw���い2½üüüùやý´

ンÏ~使用²誤»x1大�|{tz|»ÿ能性|あº~�2

作業場|ü当�»人間ý学規格²���vい»�x²確認�v���い2ÉøüÉ{由来�»�||zい¸う{1

人間ý学~^門家{助言²求�v���い2

製品²持�N��º運³�º�»作業�慎重{行sv���い2本製品{�持�運s用~ÿンùû|×º付�¹

¼vい~�
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警告： 本機�{zº~重量|あº~�2怪s²��º装置|損傷�»�x|zい¸う{1製品²持�運vx}{�
誰{~手²借ºv���い2

本製品{�指Û�¼�当社~ùó¿×º付�金具~�²使用�v���い2

÷ýüöxöÉøûúüù

÷ýüöやöÉøûúüù²接続�»前{1電源Ãý¿Ï{¹~電源Ãüù²適W{接地�¼�ÃンËンø{接続�
v���い2

感電²避�»��{1常{指�÷ýüö~指¼üù~��触覚段差¸º後方{保sv���い2

使用�zい÷ýüö1öÉøûúüù1²¿ËÅú��yv×º外�v���い2

測Û{使用�»÷ýüö1öÉøûúüù1²Ð÷Ï�1測Û»öÄúÿCATĀ1電w1温度1高度1²ンú²数~Û格
|適Wz�~~�²使用�v���い2

高電w{注意： 使用�»÷ýüö~電wÛ格{tいv理解�1}~Û格²超えzい¸う{�v���い2特{l~
2 t~Û格{tいv�¸�理解�vz�必要|あº~�2

■ ÷ýüöûÑó÷x÷ýüö~基準úüù間~Ā大測Û電w

■ ÷ýüö基準úüùx²üÉ間~Ā大õýüö³ンÀ電w

N記~ 2t~電wÛ格�÷ýüöx用途{¸sv異zº~�2ý細{tいv�1÷ýüö~þûą²û~ß様関
連Ë¿Çćン²参照�v���い2

警告： 感電²防k�»��{1ºÇýÉÃü÷~入力 BNC Ãý¿Ï1÷ýüöûÑó÷1~��÷ýüö基準úüù
~Ā大測Û電wやĀ大õýüö³ンÀ電w²超えzい¸う{注意�v���い2

接続xW断~手�²Ûsv���い： ÷ýüö出力²測Û器{接続�v{¹1÷ýüö²被測Û回路{接続�v�
��い2被測Û回路{÷ýüö~基準úüù²接続�v{¹1÷ýüö入力²接続�v���い2÷ýüö入力x÷
ýüö~基準úüù²被測Û回路{¹W断��後w1÷ýüö²測Û器{¹W断�v���い2

÷ýüö~基準úüù�1Àùンù{~�接続�v���い2

÷ýüöx²¿ËÅú²検査�v���い： 使用前{�必�÷ýüöx²¿ËÅú{損傷|zい�x²確認�v��
�いÿ÷ýüö本体1²¿ËÅú1Áüöû被覆zy~断線1裂�目1k陥Ā2損傷|あ»場合{�使用�zいw�
��い2

Àùンù基準~ºÇýÉÃü÷~使用： Àùンù基準~ºÇýÉÃü÷w使用�»場合1÷ýüö~基準úüù�
õýüö³ンÀ��zいw���い2基準úüù�接地電Oÿ0VĀ{接続�z�¼ばzº~�³2

õýüö³ンÀ測Û~使用： 本÷ýüö~基準úüù�1Û格õýüö³ンÀ電w²超えvõýüö³ンÀ��zい
w���い2
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Ü全{保Ûù検�vい�����{

<Ü全{保Ûù検�vい�����{=~Ë¿Çćン{�1製品~保Ûù検²Ü全{行う��{必要zý細z情報

|記載�¼vい~�2資格~あ»ÅüóÉ担当者ñ外�1保Ûù検手�²実行�zいw���い2保Ûù検²行
う前{�1�~<Ü全{保Ûù検�vい�����{=x<Ü全{�使用い�����{=²z¯����い2

感電²避�»��1： 露出��接続部{�触¼zいw���い2

保Ûù検�単þw行わzいw���い2： 応急処置x救急蘇生|w}»人~介x|zい限º1本製品~内部ù
検や調整²行わzいw���い2

電源²W断�v���い2： 保Ûù検~�{»Āüやāýû²外��º1ÁüÉ²開�前{1感電²避�»��1製
品~電源²Wº1電源Ãüù²電源ÃンËンø{¹抜いv���い2

電源ºン時~保Ûù検{�十V注意�v���い2： 本製品{�1t険z電wや電流|`x�vい»ÿ能性|
あº~�2保護āýû~×º外�1�³�付�1Ãンýüýンø~交換²�»前{1電源~W断1Āóöú~×º
外�ÿÿ能z場合Ā1öÉøûúüù~W断²行sv���い2

修理後~Ü全確認2： 修理²行s�後{�1常{Àùンù^通x電源~絶縁耐力²再Ñ·ó¿�v���い2

本þûą²û内~用語

本þûą²ûw�ñO~用語²使用�vい~�2

警告： 人体や生}{t害²z¸ぼ�z}¼~あ»状態や行ú²示�~�2

注意： 本機や}~à~接続機器{損害²Pえ»z}¼~あ»状態や行ú²示�~�2

本機{関�»用語

本機w�l~用語²使用�~�2

■ t険： ���{人体や生}{t険²z¸ぼ�ÿ能性|あ»�x²示�~�2

■ 警告： 人体や生}{t険²z¸ぼ�ÿ能性|あ»�x²示�~�2

■ 注意： 本製品²含�周辺機器{損傷²Pえ»ÿ能性|あ»�x²示�~�2

Ü全性{関�»重要z情報
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本製品~記号：

製品{�~記号|表記�¼vい»x}�1þûą²û²参照�v1想Û�¼»t険性x}¼¹²回避�
»��{必要z行動{tいv確認�v���いÿþûą²ûw�1�~記号�ĆüÆ{Û格²示���
{使用�¼»場合|あº~�2Ā

本製品w�1l~記号²使用�~�2

Ü全性{関�»重要z情報
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~え|}

本þûą²û{�1製品~Ü全xÃン÷ù´²ンÉ1ºÇýÉÃü÷~接続方法x電源供給方法1機器~機能xv
御x基本操作{関�»情報|記載�¼vい~�2ý細{tいv�1製品~ Helpÿøû÷Āõ±´û²参照�v��
�い2

主z特長

5ÇúüÊ MSOýüû÷ýõ±´û²z買い求�い��}あº|xう��い~�25ÇúüÊ MSOýüû÷ýõ±´
ûÿMSO58LP型Ā�18Ñăンýû式~ºÇýÉÃü÷w1入力�世界初~ FlexChannel®²ùüÉx�vzº1実質
的{あ¹ゆ»設計{zいv効率的{t¿用効果~高いÿó¿ÉùûÇÀúûû÷Āó½ンÀ²実現�~�2

■ 2U~ùó¿ûÉúüÉ{}~~~設置w}»÷³É÷ü´²持�zいýüû÷ýõ±´ûûÏ´÷

■ 周波数帯域：1GHz

■ 8ÑăンýûÿFlexChannel®入力Ā

■ 各 FlexChannel入力{�²úýÀû÷ýüöÿTekVPI®~�� BNCĀ~�� 8Ñăンýû~÷ÈÏûû÷ýüö
ÿTLP058型 FlexChannel対応ýÈó¿û÷ýüöĀ~い�¼�接続ÿ能

■ Åン÷ûûüüøĀ大 6.25GS/s

■ �yv~Ñăンýû{zいv1125Mý´ンø~üÃüù長

■ Ā大波形×º込�üüø 500,000波形／秒

■ FastFrame™{¸»ËÀāンøûāĂúû²¿´ÈÇćンw�1複数~øú¼û´ùンø²使用�»�xw1時間的{
ö¼�´ùンø�1²¿´ÈÇćンûāĂú~内容²観測�z|¹1高いÅン÷ûûüüøw×º込��x|ÿ能

■ ×º込�演算波形1基準波形1ĀÉ波形~設Û限度�z�ÿ実�~波形数�使用ÿ能zÇÉöĀûāĂú{
依`Ā2

■ 組�込�º÷Çćンx�v150MHz~任意関数~生器ÿAFGĀ1÷ÈÏûûüûøāüÏÿDVMĀøú¼周波数»¶
ンÏ²�用意

■ ã張Çú²ûûĀÉûøú¼／解析º÷Çćン²使用�»�xw1�~�~z規格~ĀÉw~÷Ãüù／øú¼|
ÿ能2<Çú²ûûĀÉxøú¼ûº÷Çćン=~øû÷ûøôó¿²参照

■ āワü／ÈóÏ測Ûº÷Çćン²使用�»�xw1�~�~z測Û／解析機能²追加ÿ能2<ã張āワü解析=

z¸s<ã張ÈóÏ解析=º÷Çćン~øû÷ûøôó¿²参照

関連�»þûą²û

関連�»þûą²û²使用�v1機器~機能や機器~遠隔÷ýÀùÿンÀz¸s遠隔操作方法1操作理論~理
解方法1疑わ�いĂÈąüû~交換方法1}~à~ÏÉ¿~実行方法{関�»情報²入手�v���い2
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MSO58LP型~þûą²û

知º�い情報 使用�»þûą²û

機器~機能~使用方法 5ÇúüÊ MSOÿMSO58LP型Ā´ンÉøüûz¸sÜ全性{関�»þûą²ûÿ本
書2当社部品番号 071-3568-xx2機器{標準w付属Ā2英語版1日本語版1簡体_中
国語版~ 1冊~þûą²û2ýÇ²語版�当社~ WebÅ´ø{¹入手ÿ能ÿ当社部
品番号 077-1404-xxĀ
5ÇúüÊ／6ÇúüÊ MSO~øû÷ÿ当社部品番号 077-1303-xx2機器~swÿ能
ĀüÈćン~øû÷2www.tektronix.com/downloads¸º入手ÿ能Ā

機器²遠隔w操作�»方
法

5ÇúüÊ／6ÇúüÊ MSO~÷ýÀùþûþûą²ûÿ当社部品番号 077-1305-xx2
www.tek.com/downloads¸º入手ÿ能Ā

機器~ß様z¸s機器~
ß様x~適合性²確認�
»手�

5ÇúüÊ MSO~ MSO54型1MSO56型1MSO58型1MSO58LP型~ß様z¸s性能
確認用ö¿û»ûûúõ±üンÉÿ当社部品番号 077-1306-xx2www.tek.com/downloads
¸º入手ÿ能Ā

TLP058ýÈó¿û÷ýüö
~使用

TLP058型 FlexChannel®ýÈó¿û÷ýüö×扱®明書ÿ当社部品番号 071-3515-xx2
www.tek.com/downloads¸º入手ÿ能Ā

作業Āw使用�»��~
機器~変換

MSO58LP型~作業Ā変換½óø×扱®明書ÿ当社部品番号 075-1102-xx2
www.tek.com/downloads¸º入手ÿ能Ā

~え|}  
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本機~設置

\ù²¿ËÅú~確認

注文���~|�yvz手元{^い��x²確認�v���い2足ºzい�~|あ»場合{�1当社»ÉÏþûÅý
üø{z問い合わ����い2X米：1-800-833-9200~wz電û���い2世界~à~地域w�1www.tek.com {²¿
ËÉ�1z近�~ï理店²z探����い2

本機~付属品一覧²見v1注文品xÉÏンÐüùû²¿ËÅú|�yv^いvい»{確認�v���い2Çú²ûû
ĀÉxøú¼ûº÷Çćン1āワü測Ûº÷Çćンzyý場出荷時実装º÷Çćン²購入��場合{�1Helpÿøû
÷Ā> Aboutÿ概要Ā²Ïó÷�v1}~º÷Çćン| Installed Optionsÿ実装º÷ÇćンĀ表{掲載�¼vい»�x²確
認�v���い2

MSO58LP型~ÉÏンÐüùû²¿ËÅú

品] 数量 当社部品番号

5ÇúüÊ MSOÿMSO58LP型Ā~設置xÜ全性{関�»þûą²û 1 071-3568-xx

電源Áüöû 1 úüÈćン{¸º異z
»

校l証明書 1 －

ý場出荷時実装ù´ËンÉ~üýüø 1 －

動作要件

高い測Û精度xÜ全z機器動作²確保�»��{1動作温度1電力1高度1信号入力電w~各必須範ö内w�
~ºÇýÉÃü÷²使用�v���い2

環境要件

特性 ®明

動作温度 0℃～＋ 50℃ÿ＋ 32°F～＋ 122°FĀ
l��冷却�»��{1本機~側面{¹ 2 ´ンÑÿ51mmĀ~範ö{� 害
物²置{zいw���い2

動作�度 ＋ 40℃ÿ＋ 104ﾟFĀñOw相対�度 5%～90%ÿRHĀÿ結露~zい状態Ā
＋ 40 ℃ÿ＋ 104 ﾟFĀ～ ＋ 50 ℃ÿ＋ 122 ﾟFĀw相対�度 5% ～ 55%ÿRH) ÿ結
露~zい状態Ā

動作高度 3,000mÿ9,842 õ³üøĀñO

MSO58LP型~設置xÜ全性{関�»þûą²û 1



電力要件

特性 ®明

電源電w 100V～240VAC RMS1±10%1単相
電源周波数 50/60Hz1100～240V

400Hz1115V
消¿電力 全機種共通：Ā大 400W

入力信号要件

入力信号²許容v限内{à�»�xw1l確z測Û²確保�1²úýÀx÷ÈÏû~÷ýüö~��機器x~損
傷²防~~�2

入力信号|ñO~要件~範ö内{あ»�x²確認�~�2

入力 ®明

²úýÀ入力Ñăンýû11MΩ設Û1BNCw
Ā大入力電w

300VRMS
測Û»öÄú II

²úýÀ入力Ñăンýû150Ω設Û1BNCw
Ā大入力電w

5VRMS

÷ÈÏû入力Ñăンýû1÷ÈÏû入力wĀ
大入力電wüンÈ

÷ýüöÛ格表記~確認
TLP058型~場合：±42VP

Ref Inÿ基準入力Ā：BNCwĀ大入力電wÿ後
部āýûĀ

7VPP

AUX øú¼入力 ±5VRMS

機器~ùó¿x~設置

MSO58LP型²標準型~ 19"機器ùó¿{設置�»�{�1ñO~指示{従sv���い2

MSO58LP型�ùó¿固Û用金具wÇăüÇ{設置�¼�状態w出荷�¼~�2付属~²¿ËÅú袋~üûøxワ
óÇă²使用�v1ùó¿{ú²ûùó¿ûöùÁóø²×º付�~�2

作業Āw MSO58LP型²使用�»{�1MSO58LP型~作業Ā変換½óøÿ当社部品番号 020-3180-xxĀ²購入�1
設置�»必要|あº~�2�~½óø{�1ÇăüÇ足xÿンùû|入svいv1作業Ā{本機²置��x|w}~
�2

l~手�{従sv1ùó¿{本機²設置�~�2

本機~設置  
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警告： �|²�zい¸う{1本機~設置� 2人w行sv���い2

1. 付属品~üûøxワóÇă² 2組使用�v1ú²ûùó¿固Û用金具~ 1t²ùó¿~後部{×º付�~�2手
w締�付�~�2
 

 

2. 2人w本機²支え1ÇăüÇûùó¿固Û用金具|ú²ûùó¿固Û用金具{差�込~¼»¸う{ùó¿~前面
{¹本機²挿入�~�2

3. 本機|ùó¿~前面x\一�面{z»~w前面{¹押�込�続�~�2

4. 付属品~üûøxワóÇă² 4組使用�v1本機~前面²ùó¿{×º付�~�2手w締�付�1本機²支え
~�2

5. ùó¿~後部{¹1ú²ûùó¿固Û用金具|ú²ûùó¿x\一�面{z»~w 2番目~ú²ûùó¿固Û用金
具²本機~ÇăüÇûùó¿固Û用金具{Éù´ù�~�2

6. 付属品~üûøxワóÇă² 2組使用�v12番目~ú²ûùó¿固Û用金具²ùó¿~後部{×º付�~�2
手w締�付�~�2

7. 1.1NmÿûąüøンûāüÏĀ~w手w締�付�~�2

8. 5/16 ´ンÑ~üンÑ²使用�v1両側~ùó¿固Û用金具²Ëンöú{付属~~角üûø² 2個×º付�1固
Û用金具²所Û~O置{固Û�1前面ùó¿~ýÈ|外¼�x}{本機|誤svVö�zい¸う{�~�ÿñ
O~´āüÈ²参照Ā2両側{ 4 »所~üûøO置|あº~�ÿ´āüÈ²参照Ā20.7NmÿûąüøンûāüÏĀ~
w固Û用金具~固Ûüûø²締�付�~�2
 

 

9. 必要{応�v後部ÇăüÇ{電源ÃüùxÁüöû²×º付�~�2

ùó¿ûþ¶ンø~指示終わº：

 本機~設置
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ºÇýÉÃü÷~固Ûÿýó¿Ā

÷ýāö³~損失²防���{1ºÇýÉÃü÷²öÉøûùンÑや設備ùó¿{ýó¿�~�2

標準的zþüøāÍÃン用Ë½ąúö³ûýó¿²ºÇýÉÃü÷~後部āýû{×º付�v1ºÇýÉÃü÷²作
業Āやùó¿1}~à~場所{固Û�~�2
 

 

ºÇýÉÃü÷x~電源投入

�~手�w�1ºÇýÉÃü÷²ù´ン電源{接続�1ºÇýÉÃü÷x~電源~投入x遮断²行い~�2ºÇý
ÉÃü÷² AC電源{接続�»時{�必�1本機{\ù�¼vい»電源Ãüù²使用�v���い2

前提条件：ºÇýÉÃü÷{\ù�¼vい» AC電源Ãüù²使用�v���い2

1. 付属~電源Ãüù²ºÇýÉÃü÷~電源Ãý¿Ï{接続�~�2

÷ 1 : MSO58LP型~電源ÃüùûÃý¿Ïx電源ÉÏンĀ´ûÉ´óÑ

2. 電源Ãüù²適Wz AC電源{接続�~�2
AC電源Ãüù|^通状態~電源回路{接続�¼»x1電力|電源供給部x}~à~基盤{供給�¼1本機
| StandbyÿÉÏンĀ´ĀĂüù{入º~�2

3. 本機~電源²ºン~��ºõ{�»{�1前面āýû~電源üÏン²押�~�2

電源üÏン~色�本機~電源ÉöüÏÉ²示�~�：

無灯–AC電力|投入�¼vいzい

黄色–StandbyÿÉÏンĀ´ĀĂüù

青色–電源ºン

4. 本機~電源²完全{W»{�1電源Ãüù²抜}~�2

本機~設置  
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āワüºンûËûõûöÉøw~ºÇýÉÃü÷~合格~確認

āワüºンûËûõûöÉøw�1ºÇýÉÃü÷~全機種|起動後{l常{作動�»{²確認�~�2

前提条件：MSO58LP型w�1ĂûÏ²後部āýû~ó÷º出力{接続�1þ¶É² USBýüø{接続�~�2

1. ºÇýÉÃü÷~電源²入¼v1ºÇýÉÃü÷~É¿úüン{表示|出»~w待�~�2

2. N端~āûąüûĀüw UtilityÿĆüö³úö³Ā> Self TestÿËûõûöÉøĀ²選択�1Self TestÿËûõûöÉøĀ
~Ãンõ³ÀüüÇćンûāûąü²開}~�2

3. �yv~āワüºンûËûõûöÉø~ÉöüÏÉ| Passedÿ合格Ā{zsvい»�x²確認�~�2

い�¼{~āワüºンûËûõûöÉø~結果| FailedÿO合格Āx表示�¼vい»場合：

a. ºÇýÉÃü÷~電源²入¼直�~�2

b. UtilityÿĆüö³úö³Ā> Self TestÿËûõûöÉøĀ²Ïó÷�~�2}¼w�い�¼{~āワüºンûËû
õûöÉø~結果| FailedÿO合格Āx表示�¼»場合{�1当社»ÉÏþûÅýüø{問い合わ�v���
い2

÷ýüö~接続

÷ýüöxÁüöû²使svºÇýÉÃü÷²被測Û装置ÿDUTĀ{接続�~�2÷ýüö�信号測Û~ûüÊ{
Ā適z�~²使用�v���い2

÷ 2 : MSO58LP型x~÷ýüö~接続

TPP0500型1TPP1000型1TekVPI+1TekVPI1~��Åýüø�¼vい»}~à~当社²úýÀû÷ýüö²
FlexChannel Ãý¿Ï{挿入�v接続�~�2÷ýüö�完全{挿入�¼»x1÷ýüö~ùüÉûùóÑ|»Ñóx
音²立vvýó¿�¼~�2

本機~設置
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TekVPI÷ýüö{tいv�1�~÷ýüö~Ñăンýû入力āùāüÏÿ帯域幅1減衰比1ÏüÿýüÇćンzyĀ
|自動w設Û�¼~�2÷ýüö{ MenuÿāûąüĀüÏン|あ»場合1}~üÏン²押�vÉ¿úüンN~Ãンõ
³ÀüüÇćンûāûąü²開}~�2²¿ö³öz÷ýüö~×扱®明書{従svāùāüÏÿ自動Ìý1÷¼¶É
zyĀ²設Û�~�2

TLP058型 FlexChannelýÈó¿û÷ýüö~�� TDP7700ÇúüÊ TriMode™÷ýüö²接続�»{�1ñO~手
�²実行�~�2

1. ýó¿ûüĀü²²ンýó¿O置{移動��1ýó¿ûüĀü|中央{戻»~w待�~�2

2. FlexChannel Ãý¿Ï{÷ýüö²挿入�1÷ýüö|完全{挿入�¼výó¿ûā»ûÊĀ~»Ñóxいう音|
�»~w押�込�~�2

3. ýó¿ûüĀü²ýó¿O置{移動��~�2ÉöüÏÉûù´ø|緑色{ù灯�~�2

4. TLP058÷ýüö²×º外�{�1ýó¿ûüĀü²²ンýó¿O置{移動���~~÷ýüö²引}抜}~�2
÷ýüö²×º外�vい»時{úüンûÁüöû²引s張¹zいw���い2

BNC~÷ýüö~��Áüöû²Ñăンýû BNC差�込�Ãý¿Ï{挿入�v接続�1ýó¿ûā»ûÊĀ²ýó¿
�¼»~w時計回º{回�~�2

注： ÷ýüö²接続�v�1}~Ñăンýû�自動的{有効{�zº~�³ÿ²¿ö³ö{�v���いĀ2÷ýüö
~��Áüöû~設Ûÿ帯域幅1減衰1ÏüÿýüÇćンzyĀ~確認や変更²行う{�1ChannelÿÑăンýûĀĀó
È²ÐöûÏó÷�v}~Ãンõ³ÀüüÇćンûāûąü²開}~�2

本機~設置
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機器~ý細

MSO58LP型~前面āýûûÃンøýüûxÃý¿Ï
前面āýûw�1本機~電源ºン／ºõ1÷ýüö~��Áüöû²使用�v信号²接続1外部øú¼~入力信
号²接続1USB÷Ā´É~装着1÷ýüö補l信号~²¿ËÉ²行い~�2
 

 

1. FlexChannel®÷ýüöûÃý¿Ï：

FlexChannel®Ãý¿Ï�1TekVPI+測Û÷ýüö1TekVPI測Û÷ýüö1BNCØ動÷ýüö1TLP058型
FlexChannel®ýÈó¿û÷ýüö1BNCÁüöû~�yv{対応�vい~�2÷ýüö~接続�簡単w1÷ýü
ö²»Ñóx音|�»~w�s{ºxÃý¿Ï{押�込���w�2÷ýüö~接続(5 úüÈ)²参照

2. LANÉöüÏÉ LED：

ýóøワü¿接続x²¿ö³óö³ûÉöüÏÉ²示�~�：

■ ºõ－本機{電力|供給�¼vいzい

■ 緑－ýóøワü¿接続良好

■ 赤－ýóøワü¿接続O良~��未接続
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3. ÷ýüö補lÃý¿Ï：
 

 

÷ýüö補l用接続部{�1ÀùンùûÃý¿Ïx 1kHz~方形波ÍüÉ|あº1Ø動÷ýüö~高周波数応答
~調整ÿ÷ýüö補lĀ{使用�~�2ºÇýÉÃü÷��~信号²利用�v1Åýüø�¼vい»÷ýüö~
自動補l²行い~�2TPP0500B型÷ýüö~�� TPP1000型÷ýüö~補l(13 úüÈ) ²参照�v���
い2

ÀùンùûÃý¿Ï²使用�v1帯電防k用úÉøûÉøùó÷²付�v1DUT²扱う~��試験�»�~静電気
損傷ÿESDĀ~ÿ能性²P減�»�x�ÿ能w�2

4. USBûÉøûýüø：

USBýüø�前面āýû~右O{あº~�2÷üÏÿ機器~õ±üĀ¶·²更新1波形1設Û1É¿úüンû½
ă÷ÑăzyĀ~保`やúÃüû|ÿ能z USB õùóÇąûùù´ö²接続�»{1~��þ¶Éや½üüüù
zy~周辺機器²接続�v���い2

5. Aux Trig øú¼入力Ãý¿Ï：

外部øú¼~入力信号²接続w}» SMA Ãý¿Ï2AUX In øú¼信号�¸óÈûøú¼ûĂüù²指Û�v使用�
~�2

6. AcqÉöüÏÉ LED：

本機~øú¼／²¿´ÈÇćンûÉöüÏÉ²示�~�：

■ 緑－øú¼�¼vい»

■ 黄色－待機状態�|~�øú¼�¼vいzい

■ 赤－²¿´ÈÇćン停k

7. 電源ºン／ÉÏンĀ´ûüÏン：

本機~電源²ºン／ºõ{�~�2電源üÏン~色�本機~電源ÉöüÏÉ²示�~�：

■ 無灯–AC電力|投入�¼vいzい
■ 黄色–StandbyÿÉÏンĀ´ĀĂüù
■ 青色–電源ºン

機器~ý細  
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後部āýû~接続部

後部āýû~接続部�1ºÇýÉÃü÷x~電源供給x1ýóøワü¿1USB÷Ā´É1ó÷º1úõ±üンÉ信
号1AFG出力~接続~��{使用�~�2
 

 

1. 電源ÃüùûÃý¿Ï：本製品用{指Û�¼1使用�¼»国w認Û�¼�電源Ãüù~�²使用�v���い2

2. Ref In：高精度 10MHz úõ±üンÉ信号²ºÇýÉÃü÷{接続�v測Û~精度²確保�~�2

3. AUX Out：øú¼û´ùンøw信号øùンÈÇćン²生r�110MHz~úõ±üンÉ信号²出力1~�� AFG{¹\
期信号²出力�~�2

4. AFG Out：º÷Çćン~任意波形／õ±ン¿ÇćンûÈ·ýüüÏÿAFGĀ用~信号出力w�2

5. ó÷º出力ÿDisplay Port1VGA1DVI-DĀ：外部~ĂûÏ~��÷ýÈ·¿Ï{接続�vºÇýÉÃü÷~画面²表
示�~�2

6. USB÷Ā´Éûýüø：USBTMC÷ýøÃû²使用�vºÇýÉÃü÷²遠隔操作�»場合{ PC{接続�~
�2

7. USBûÉøûýüø：USB āĂúû÷Ā´É1½üüüù1~��þ¶É²接続�~�2

8. LAN Ãý¿ÏÿRJ-45Ā：ºÇýÉÃü÷² 10/100/1000 Base-Týü»ûû¸ú²ûýóøワü¿{接続�~�2

9. Ë½ąúö³ûýó¿ûÃý¿Ï：標準的z PC/þüøāÍÃン用ýó¿ûÁüöû²使用�v1ºÇýÉÃü÷²作
業Āや}~à~場所{固Û�~�2

 機器~ý細
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Àùõ³»ûûĆüÆû´ンÏõ·üÉ

MSO58LP型�÷ýÀùĀv御用{設計�¼vい~�|1製品~øû÷ûøôó¿²組�込³�Àùõ³»ûûĆü
Æû´ンÏõ·üÉ�備えvい~�2ĂûÏxþ¶É²機器{接続�»{1öù¶Æ²使用�výóøワü¿接続�¼
�機器{²¿ËÉ�»�x{¸svÀùõ³»ûû´ンÏõ·üÉ{²¿ËÉw}~�2

Ā_解像度 1,920ÿ水�Ā×1,080ÿ垂直Āô¿Ëûÿ高品OĀ~ĂûÏÿ標準~��ÏóÑÉ¿úüンĀ²後部āýû~
ó÷º出力Ãý¿Ï{接続�~�2

öù¶Æ{¹²¿ËÉ�»{�1機器~ IP²ùüÉ²öù¶Æ~²ùüÉûõ³üûù{入力�1機器~öù¶Æ~
¸う�}úüÈ²開}~�2É¿úüン~þ側{あ» Instrument Controlÿ機器v御Āÿe*Scope®Āúン¿²¿úó¿�1À
ùõ³»ûû´ンÏõ·üÉ²開}~�2

þ¶ÉÿUSBÁüöûĀ~��þ¶ÉûùンÀûÿワ´ĄüÉ USBþ¶É用Ā²任意~ USBýüø{接続�~�2

Àùõ³»ûûĆüÆû´ンÏõ·üÉ~概要x使用法{tいvý���1>5 Series MSO (MSO54, MSO56, MSO58)
Installation and Safety Manual?ÿ5ÇúüÊ MSOÿMSO54型1MSO56型1MSO58型Ā~設置xÜ全性{関�»þûą²
û：当社部品番号 071-3514-xxĀ²参照�v���い2�~þûą²û� www.tek.com/product-support{¹Ð¶ンýü
ùw}~�2
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本機~設Û

Ï´ĀûÎüンx¿ýó¿ûúüù²¶øûõ¹üþóø~設Û

保`��õ±´û{l�い日時情報|þü¿�¼»¸う{1zQい~地域{Ï´ĀûÎüン²合わ�~�2~�1Ï
´Āûõ¹üþóøÿ12時間¿ýó¿~�� 24時間¿ýó¿Ā�設Ûw}~�2

MSO58LP型wĆüÆû´ンÏõ·üÉ{²¿ËÉ�»{�1本機後部~ó÷ºûýüø{ĂûÏ²接続�1任意~
USBûÉøûýüø{þ¶É²接続�~�2úĂüøûĂûÏ|ÏóÑ操作{対応�vい»場合1þ¶É²接続�»必
要�あº~�³2Weböù¶Æ{機器~ IP²ùüÉ²入力�v1ýóøワü¿接続�¼�機器~ĆüÆû´ンÏõ·
üÉ{úĂüøû²¿ËÉ�»�x�w}~�2

MSO58LP型w�~Ãンøýüû²úĂüø設Û�»~���~ÏÉ¿²実行�»��{使用�»l�いÃþンù{
tいv�1ºÇýÉÃü÷û÷ýÀùþûþûą²ûÿ当社部品番号 077-1305-xxĀ²参照�v���い2

1. 画面右O{あ» Date/Timeÿ日時ĀĀóÈ²ÐöûÏó÷�vÃンõ³ÀüüÇćンûāûąü²開}~�2
 

 

2. 画面N~日時²非表示{�»{�1Displayÿ表示ĀüÏン²Ïó÷�v OffÿºõĀ{�~�2
日時²再s表示�»{�1日時ĀóÈ|表示�¼vい�部V~空白~¸ú²²ÐöûÏó÷�vÃンõ³Àü
üÇćンûāûąü²開}1Displayÿ表示ĀüÏン² OnÿºンĀ{�~�2

3. Ï´Āûõ¹üþóøÿ12 Hourÿ12時間Ā~�� 24 Hourÿ24時間ĀĀ²選択�~�2

4. Time ZoneÿÏ´ĀûÎüンĀõ³üûù²Ïó÷�v適WzÏ´ĀûÎüン²選択�~�2

5. āûąü~外~任意~部V²Ïó÷�vāûąü²閉�~�2

Ā新õ±üĀ¶·²~Ð¶ンýüùz¸s´ンÉøüû

Ā新~õ±üĀ¶·²²´ンÉøüû�vz�x1ºÇýÉÃü÷{¸»測Û~高い精度²維持�»~{役立�~
�2

MSO58LP型wĆüÆû´ンÏõ·üÉ{²¿ËÉ�»{�1本機後部~ó÷ºûýüø{ĂûÏ²接続�1任意~
USBûÉøûýüø{þ¶É²接続�~�2úĂüøûĂûÏ|ÏóÑ操作{対応�vい»場合1þ¶É²接続�»必
要�あº~�³2Weböù¶Æ{機器~ IP²ùüÉ²入力�v1ýóøワü¿接続�¼�機器~ĆüÆû´ンÏõ·
üÉ{úĂüøû²¿ËÉ�»�x�w}~�2
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USB ùù´ö経由~ºÇýÉÃü÷ûõ±üĀ¶·²~更新
前提条件：必�1ºÇýÉÃü÷{´ンÉøüû�¼vい»õ±üĀ¶·²~現x~ĀüÈćン²確認�vzいv�
��いÿHelpÿøû÷Ā> Aboutÿ概要ĀĀ2

1. PCw Weböù¶Æ²起動�v1www.tek.com/product-support{²¿ËÉ�~�2

2. 検索õ³üûù{ºÇýÉÃü÷~型]²入力�v Go²¿úó¿�~�2

3. É¿úüン²OÉ¿ýüû�1SoftwareÿÍõø¶·²ĀÏö²¿úó¿�~�2

4. 掲載�¼vい»入手ÿ能zõ±üĀ¶·²ûĀüÈćンÿWindows版~��非 Windows版Ā|1z使い~ºÇý
ÉÃü÷~�~¸º�新�い場合{�1}~õ±´û²選択�v PC{Ð¶ンýüù�v���い2

5. Ð¶ンýüù��õ±üĀ¶·²{付属�»´ンÉøüû方法~®明{従sv1õ±üĀ¶·²û´ンÉøüûû
õ±´û²作r�~�2

6. õ±üĀ¶·²û´ンÉøüûûõ±´û² USB ùù´ö{Ãôü�~�2

7. USB ùù´ö²ºÇýÉÃü÷~い�¼{~ USBûÉøûýüø{差�込�~�2

a. 非 Windows版~ºÇýÉÃü÷w�1õ±üĀ¶·²ûõ±´û|保`�¼vい» USB ùù´ö²検出�v
´ンÉøüû処理²開始�~�2画面~指示{従svõ±üĀ¶·²²´ンÉøüû�~�2

b. Windows版~ºÇýÉÃü÷w�1õ±üĀ¶·²²更新�»前{ TekScope÷ýÀùĀ²閉�~�2
Explorer²開いv1USB ùù´ö{格納�¼�õ±üĀ¶·²更新õ±´û²実行�~�2~��1õ±üĀ
¶·²更新õ±´û²÷É¿øó÷{Ãôü�1}�{¹õ±´û²実行�~�2画面~指示{従svõ±ü
Ā¶·²²´ンÉøüû�~�2

注： õ±üĀ¶·²~´ンÉøüû|完了�»~w�1ºÇýÉÃü÷~電源²Ws�º1USB õùóÇąûùù
´ö²×º外��º�zいw���い2ºÇýÉÃü÷~電源²Wsv¸い時期²知¹�»āóËüÈ|ºÇý
ÉÃü÷{表示�¼~�2

8. õ±üĀ¶·²~´ンÉøüû|完了��¹1USB ùù´ö²×º外�1ºÇýÉÃü÷²再起動�~�2

õ±üĀ¶·²|l��´ンÉøüû�¼��x²確認�»{�1āûąüûĀü{¹

a. Helpÿøû÷Ā> Aboutÿ概要Ā²Ïó÷�~�2

b. 画面{表示�¼vい»õ±üĀ¶·²ûĀüÈćン番号|1Ð¶ンýüù��ĀüÈćン~番号x\�wあ
»�x²確認�~�2

信号経路補lÿSPCĀ~実行
高い測Û精度²確保�»��{Û期的{ SPC²実行�v���い2周öÿý内Ā温度| 5℃ÿ9°FĀñN変W��場
合�必� SPC²実行�v���い2~�15mV/divñO~垂直軸ÉÁüû設Û²使用�»場合{�1週{一度1
SPC²実行�v���い2

MSO58LP型wĆüÆû´ンÏõ·üÉ{²¿ËÉ�»{�1本機後部~ó÷ºûýüø{ĂûÏ²接続�1任意~
USBûÉøûýüø{þ¶É²接続�~�2úĂüøûĂûÏ|ÏóÑ操作{対応�vい»場合1þ¶É²接続�»必
要�あº~�³2Weböù¶Æ{機器~ IP²ùüÉ²入力�v1ýóøワü¿接続�¼�機器~ĆüÆû´ンÏõ·
üÉ{úĂüøû²¿ËÉ�»�x�w}~�2

MSO58LP型w�~Ãンøýüû²úĂüø設Û�»~���~ÏÉ¿²実行�»��{使用�»l�いÃþンù{
tいv�1ºÇýÉÃü÷û÷ýÀùþûþûą²ûÿ当社部品番号 077-1305-xxĀ²参照�v���い2

信号経路補lÿSPCĀ�1周ö温度~変Wや長期ùúõø{¸sv生�»内部信号経路~ DCüùû~確度~誤
差²修l�~�2SPC²Û期的{実行�zい場合1Pい V/div設Ûw保証�¼vい»ºÇýÉÃü÷性能²得¹¼
zいÿ能性|あº~�2
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前提条件：必�1前面āýû~Ñăンýû入力xú²āýû~信号Ãý¿Ï{¹÷ýüöxÁüöû²�yv×º
外�v���い2

1. ºÇýÉÃü÷~電源²ºン{�120VñN¶¹üĀû²ó÷�~�2

2. UtilityÿĆüö³úö³Ā> Calibrationÿ校lĀ²Ïó÷�~�2

3. Run SPCÿSPC~実行Ā²Ïó÷�~�2SPC~実行中�1SPC StatusÿSPCÉöüÏÉĀ~úüù²¶ø{
Runningÿ実行中Āx表示�¼~�21Ñăンýûあ�º~ SPC~実行{�数V{{»場合|あ»��1SPC
ÉöüÏÉ~āóËüÈ| Passÿ合格Ā{変わ»~w待sv{¹1÷ýüö²再接続�vºÇýÉÃü÷²使用
�»¸う{�v���い2

注意： Abort SPCÿSPC~中kĀ²Ïó÷�¼ば SPC校l²中kw}~�2中k�»xÑăンýû�未補l~
~~xz»ÿ能性|あº1}~場合�測Û~精度|O|»z}¼|あº~�2SPC²中k�»場合{�必
�1本機²使用�v測Û²実施�»前{ SPC手�²完全{実行�v���い2

4. SPC|完了��¹ Calibrationÿ校lĀÃンõ³ÀüüÇćンûÐ´²ýÀ²閉�~�2

5. SPC{失敗��場合{�¸ùüûāóËüÈûö½Éø²書}留�vzいv���い2÷ýüöxÁüöû|�
yv×º外�¼vい»�x²確認�1SPC²�う一度実行�~�2}¼w� SPC{失敗��場合{�1当社»
ÉÏþûÅýüø{問い合わ�v���い2

TPP0500B型÷ýüö~�� TPP1000型÷ýüö~補l
高度z波形×º込�x高精度~測Û²確保�»��{1÷ýüö補l{¸º÷ýüö~高周波応答²調整�~
�2本ºÇýÉÃü÷w�1÷ýüöxÑăンýû~無数~組�合わ�{対�»補l値~試験x保`²自動w実
行w}~�2

MSO58LP型wĆüÆû´ンÏõ·üÉ{²¿ËÉ�»{�1本機後部~ó÷ºûýüø{ĂûÏ²接続�1任意~
USBûÉøûýüø{þ¶É²接続�~�2úĂüøûĂûÏ|ÏóÑ操作{対応�vい»場合1þ¶É²接続�»必
要�あº~�³2Weböù¶Æ{機器~ IP²ùüÉ²入力�v1ýóøワü¿接続�¼�機器~ĆüÆû´ンÏõ·
üÉ{úĂüøû²¿ËÉ�»�x�w}~�2

MSO58LP型w�~Ãンøýüû²úĂüø設Û�»~���~ÏÉ¿²実行�»��{使用�»l�いÃþンù{
tいv�1ºÇýÉÃü÷û÷ýÀùþûþûą²ûÿ当社部品番号 077-1305-xxĀ²参照�v���い2

本ºÇýÉÃü÷w�1÷ýüöxÑăンýû~組�合わ��x{補l値|保`�¼1÷ýüö²接続�»x自動
w補l値||s出�¼~�2ChannelÿÑăンýûĀÃンõ³ÀüüÇćンûāûąü~ Probe Setupÿ÷ýüöûËóø²
ó÷Āāýû{�1÷ýüö補lÉöüÏÉ|表示�¼~�2

■ Probe Compensation Statusÿ÷ýüö補lÉöüÏÉĀõ³üûù{ Passÿ合格Āx表示�¼vい»場合1}~÷ý
üö�補l�¼vzº使用ÿ能z状態w�2

■ Probe Compensation Statusÿ÷ýüö補lÉöüÏÉĀõ³üûù{ Defaultÿ÷õ¹ûøĀx表示�¼vい»場合1
×º付��÷ýüö�~�補l�¼vいzい��1�~÷ýüö補l手�²実行�»必要|あº~�2

■ Probe Compensation Statusÿ÷ýüö補lÉöüÏÉĀõ³üûù{ FailÿO合格Āx表示�¼vい»場合1×º付
��÷ýüöx~÷ýüö補l手�|失敗�vい~�2}~÷ýüö²接続�直�v1�う一度÷ýüö補l
²実行�v���い2

■ āýû{÷ýüö補lÉöüÏÉûõ³üûù|表示�¼vいzい場合�1�~ºÇýÉÃü÷w�}~÷ý
üö~補l値²保`w}~�³2本ºÇýÉÃü÷~ Helpÿøû÷Ā{¹1÷ýüö補l機能{Åýüø�¼
vいzいØ動÷ýüö²手動w補l�»方法²確認�v���い2

TPP0500B型÷ýüö1TPP1000型÷ýüö1~��Åýüø�¼vい»}~à~ TPPÇúüÊ~÷ýüö²�~
ºÇýÉÃü÷{接続�»xÉöüÏÉ| Defaultÿ÷õ¹ûøĀx表示�¼�場合{1�~手�²用いv÷ýüö~
補l²行い~�2
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注： Default Setupÿ÷õ¹ûøûËóø²ó÷Ā{¸º÷ýüö補l値|消去�¼»�x�あº~�³2ý場校lw�
保`�¼�÷ýüö補l値|�yv消去�¼~�2

前提条件：÷ýüö補l²行う時{�必�1ºÇýÉÃü÷{電源²入¼v少z�x� 20V間待sv{¹補l²
開始�v���い2

1. Åýüø�¼vい»÷ýüö²入力Ñăンýû{接続�~�2

2. ÷ýüöûÑó÷x}~÷ýüö~Àùンùûúüù²1ºÇýÉÃü÷~右O {あ» PROBE COMPÿ÷ýüö補
lĀ端子{接続�~�ÿO÷²参照Ā2

÷ 3 : MSO58LP型w~÷ýüö補l~接続

÷ýüöûÑó÷² 1kHz ÍüÉ{接続�1Àùンùû¿úó÷²Àùンù{接続�~�2Ā良~結果²得»��
{1÷ýüöûÑó÷~²¿ËÅú²�yv×º外�1÷ýüöûÑó÷² 1kHz Ãý¿Ï{直接×º付�~�2

注： PROBE COMPÿ÷ýüö補lĀ端子{\時{複数~÷ýüö²接続�»�x�w}~�³2

3. �yv~Ñăンýû²ºõ{�~�2

4. ÷ýüö|接続�¼vい»Ñăンýû²ºン{�~�2

5. MSO58LP型w�1āûąüûĀü{¹ Fileÿõ±´ûĀ > AutosetÿºüøËóøĀ²選択�~�2É¿úüン{方形
波|表示�¼~�2

6. 補l�»Ñăンýû~ĀóÈ²ÐöûÏó÷�~�2

7. Probe Setupÿ÷ýüöûËóø²ó÷Āāýû²Ïó÷�~�2

Probe Compensation Statusÿ÷ýüö補lÉöüÏÉĀ{ Passÿ合格Āx表示�¼vい»場合1}~÷ýüö��
~Ñăンýû{対�v�w{補l�¼vい~�2�~÷ýüö²w~Ñăンýû{移動��vÉöó÷ 1{¹
�う一度始�»{1~��w~÷ýüö²�~Ñăンýû{接続�vÉöó÷ 1{¹始�»�x|w}~�2

Probe Compensation Statusÿ÷ýüö補lÉöüÏÉĀ{ Defaultÿ÷õ¹ûøĀx表示�¼vい»場合�}~~~
�~手�²続�~�2

8. Compensate Probeÿ÷ýüö~補lĀ²Ïó÷�v Probe Compensationÿ÷ýüö補lĀÐ´²ýÀ²開}~�2

9. Compensate Probeÿ÷ýüö~補lĀ²Ïó÷�v÷ýüö補l²実行�~�2

10. Probe Compensation Statusÿ÷ýüö補lÉöüÏÉĀ{ Passÿ合格Āx表示�¼�¹1÷ýüö補l�完了w
�2PROBE COMPÿ÷ýüö補lĀ端子{¹÷ýüöûÑó÷xÀùンù²×º外�~�2

本機~設Û  
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11. N記Éöó÷²繰º返�v1Åýüø�¼vい»}¼~¼~Ø動÷ýüö²�~Ñăンýû{対�v補l�~
�2

12. N記Éöó÷²繰º返�v1Åýüø�¼vい»Ø動÷ýüö²�~ºÇýÉÃü÷~}~à~Ñăンýû{
対�v補l�~�2

注： 高精度~測Û²実現�»��{1÷ýüö²Ñăンýû{×º付��x}{�1Probe Setupÿ÷ýüöûË
óø²ó÷Āāýû²開いv1Probe Compensation Statusÿ÷ýüö補lÉöüÏÉĀ{ Passÿ合格Āx表示�¼v
い»{²確認�v���い2

ýóøワü¿ø~接続ÿLANĀ
ýóøワü¿{接続�»x1本機x~遠隔²¿ËÉ|ÿ能{zº~�2

MSO58LP型wĆüÆû´ンÏõ·üÉ{²¿ËÉ�»{�1本機後部~ó÷ºûýüø{ĂûÏ²接続�1任意~
USBûÉøûýüø{þ¶É²接続�~�2úĂüøûĂûÏ|ÏóÑ操作{対応�vい»場合1þ¶É²接続�»必
要�あº~�³2Weböù¶Æ{機器~ IP²ùüÉ²入力�v1ýóøワü¿接続�¼�機器~ĆüÆû´ンÏõ·
üÉ{úĂüøû²¿ËÉ�»�x�w}~�2

ýóøワü¿管理者x協力�v1ýóøワü¿接続{必要z情報ÿIP²ùüÉ1Âüø¶·´ IP²ùüÉ1Åöýóøû
þÉ¿1DNS IP²ùüÉzyĀ²×得�~�2

1. ºÇýÉÃü÷~ LAN Ãý¿Ï~ CAT5Áüöû²ýóøワü¿{接続�~�2

2. āûąüûĀü~ UtilityÿĆüö³úö³Ā> I/Oÿ入出力Ā²選択�v入出力Ãンõ³ÀüüÇćンûāûąü²開}
~�2

3. ýóøワü¿û²ùüÉ~情報²×得~��入力�~�2

■ DHCP|有効zýóøワü¿~場合�1Autoÿ自動Ā²Ïó÷�»x1ýóøワü¿{¹ IP ²ùüÉ情報²×
得w}~�2÷õ¹ûø~Ăüù� DHCPĂüùw�2

■ DHCP対応ýóøワü¿w�zい場合1~��本機{永続ÿ固ÛĀIP²ùüÉ|必要z場合{�1Manual
ÿ手動Ā²Ïó÷�v1IT担当者~��ÇÉöĀ管理者{¹×得�� IP²ùüÉzy~値²入力�~�2

4. Test ConnectionÿöÉø接続Ā²Ïó÷�výóøワü¿接続|機能�vい»�x²確認�~�2本機|ýóøワ
ü¿{l常{接続�¼vい»時{� LANÉöüÏÉû²´Ãン|緑色{ù灯�~�2ýóøワü¿~接続{問
題|あ»場合1ÇÉöĀ管理者{問い合わ�v���い2

MSO58LP型~前面āýû{�1ýóøワü¿~ÉöüÏÉ²表� LANÉöüÏÉ LED|あº~�2

■ ºõ－本機{電力|供給�¼vいzい

■ 緑－ýóøワü¿接続良好

■ 赤－ýóøワü¿接続O良~��未接続

本機~設Û
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Weböù¶Æ{¹~úĂüøû²¿ËÉ
Weböù¶Æ²使用�v1ýóøワü¿{接続�¼�ÿWindows 10²実行�vいzいĀ標準型~計測器{úĂüøû
²¿ËÉ�1PCN{本機~ĆüÆû´ンÏõ·üÉ²表示w}~�2

ñO~手�w�1ÿWindows 10版w�zいĀ標準型~計測器~ UI ÃンøýüûやÉ¿úüン{úĂüøû²¿ËÉ²
�»方法{tいv®明�~�2Windows 10ĀüÈćン~ UI Ãンøýüûz¸sÉ¿úüン{úĂüøû²¿ËÉ�»
{�1

前提条件：

■ ºÇýÉÃü÷�1}~ PC|接続�¼vい»ýóøワü¿{接続�¼vzº1}~ýóøワü¿{¹²¿ËÉ
w}»状態wz�¼ばzº~�³2ýóøワü¿ø~接続ÿLANĀ(15 úüÈ)²参照�v���い2

■ ²¿ËÉ�»ºÇýÉÃü÷~ IP²ùüÉ²確認�vz}~�2ºÇýÉÃü÷~ IP²ùüÉ²確認�»{
�1ºÇýÉÃü÷~āûąüûĀü{¹ UtilityÿĆüö³úö³Ā> IOÿ入出力Ā²選択�1LANāýû~ýóøワ
ü¿設Û²確認�~�2

■ ÿWindows 10º÷Çćン|´ンÉøüû�¼vいzいĀ標準型~計測器{²¿ËÉ�»{�1ñO~手�²実
行�~�2

1. ºÇýÉÃü÷x\�ýóøワü¿{接続�¼vい» PCNw Weböù¶Æ²開}~�2

2. öù¶Æ~ URL ù´ン{ºÇýÉÃü÷~ IP²ùüÉ²入力�v Enter½ü²押�~�2�xえば1
<135.62.88.157=~¸う{入力�~�2öù¶ÆwºÇýÉÃü÷~ WebúüÈ²検索�v開}~�2

3. Instrument Control (e*Scope®)ÿ機器~管理Ā²選択�~�2öù¶Æ{本機~É¿úüン|表示�¼~�2

4. þ¶É²使用�v1Weböù¶Æ{表示�¼vい»ºÇýÉÃü÷ûÃンøýüû²選択�v´ンÏù¿ö³ö操
作²行い~�2úĂüø PC~��þüøāÍÃン{ÏóÑûÉ¿úüンûĂûÏ|あ»場合1}~ĂûÏ²使用�
vºÇýÉÃü÷ûÃンøýüû{²¿ËÉw}~�2

注： e*Scopeöù¶Æ{¹本機{²¿ËÉ�»x}�1PC{¹ö½ÉøÿāÉ1IP²ùüÉ情報zyĀ²機器~ā
ûąüûõ³üûù{直接Àº付�»�x�w}~�³2�~場合1e*Scope²÷úÁüÇćン~¿úó÷üüù機
能²介x��»必要|あº~�2

e*Scopew接続�¼� PC{¹機器{ö½Éø²Ãôü�»{�1ñO~手�²実行�~�2

a. e*Scope²使用�v1機器x~接続²開}~�2

b. PCNwö½Éø²選択�1Ãôü�~�2

c. e*Scopew Ctrl-Alt-Shift²押�v1¿úó÷üüùāûąü²開}~�2

d. ö½Éø²¿úó÷üüùûõ³üûù{Àº付�~�2
e. Ctrl-Alt-Shift²押�v1öù¶Æ~¿úó÷üüùûāûąü²閉�~�2

f. e*Scope²使用�vÀº付�Y~機器~āûąü²開}1ö½Éø²Àº付��いõ³üûù{»üÍû²
移動�~�2

g. ÿ物理的½üüüù~��仮想½üüüùwĀCtrl-V²押�v1e*Scopeöù¶Æ~¿úó÷üüù{¹āû
ąüûõ³üûù{ö½Éø²Àº付�~�2

h.  4.b～ 4.g~手�²繰º返�v1à~ö½Éø{tいv� PC{¹機器xxÃôü／Àº付�²行い~�2

本機~設Û
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基本操作

Àùõ³»ûûĆüÆû´ンÏõ·üÉ²使用�vøú¼²ºン{�1波形²×º込�1測Û²行う方法{tいvý��
�1>5 Series MSO (MSO54, MSO56, MSO58) Installation and Safety Manual?ÿ5ÇúüÊ MSOÿMSO54型1MSO56型1
MSO58型Ā~設置xÜ全性{関�»þûą²û：当社部品番号 071-3514-xxĀ²参照�v���い2

機器²遠隔操作�»��{使用�»l�いÃþンù{tいv�1> 5Series MSO MSO54, MSO56, MSO58, MSO58LP
Programmer Manual?ÿ5ÇúüÊ MSOÿMSO54型1MSO56型1MSO58型1MSO58LP型Ā~÷ýÀùþûþûą²û：
当社部品番号 077-1305-xxĀ²参照�v���い2

y�¹~þûą²û� www.tek.com/product-support{¹Ð¶ンýüùw}~�2

MSO58LP型~設置xÜ全性{関�»þûą²û 17



基本操作  

18 MSO58LP型~設置xÜ全性{関�»þûą²û



āンöúンÉ

�~Ë¿Çćンw�1機器~Û期的zāンöúンÉ{必要z情報{tいv®明�~�2

注意： 破損時{»Āü²交換�»x}ñ外�1N部»Āü²機器{¹×º外�zいw���い2機器内{�ĆüÆ
|交換w}»部品�あº~�³2修理|必要z場合�機器²当社~w�返送���い2

¿úüûンÀ

機器~外部~清掃{�1乾い�ø¹{い綿布²使用�v���い2汚¼|落�zい場合�175%~´Í÷ýôûû
²ûÃüû溶液²��込~��布~��綿棒²使用�v���い2ÃンøýüûやÃý¿Ï~周º~ÿい部V~¿
úüûンÀ{�1綿棒²使用�v���い2W学洗浄剤�使用�zいw���い2ÁüÉ1Ãンøýüû類1þü½ン
Àやùùû|損傷��º1ÁüÉ~中{÷�込�恐¼|あº~�2

性能検査~実施間隔x調整

機器内部~電wz¸sÏ´ÿンÀûúõ±üンÉ�}わ�vÜÛ�vい»��1Û期的z調整²行う必要�あº~
�³2

要件x�vÛ期的z校l|k{�zい環境w�使用~場合{�1原則x�v1機器² 2,000 時間使用�»�x
{1あ»い�使用»度|高�zい場合{��{ 1 回1性能検証²実施�v���い2ºンù´ンw利用ÿ能zß様
z¸s性能検査þûą²ûÿwww.www.tek.com/product-supportĀ{記載�¼�手�{従sv実施�v���い2

>ß様z¸s性能検査þûą²û?{記載�¼�性能öÉø{āÉ�zい場合{�1機器~調整|必要z場合|
あº~�2調整�当社ÅüóÉûËンÏü{¸sv~�実施w}~�2当社ÅüóÉûËンÏü~連絡Y{tいv
�1�~þûą²û~巻頭~著作権情報~úüÈ²参照�v���い2

交換部品úÉø

�~Ë¿Çćンw�1�使用~機器~交換w}»部品{tいv®明�~�2ü当�»Ë¿Çćン~úÉø²使用�v
交換部品²特Û�1交換部品²注文�v���い2

ÉÏンÐüùû²¿ËÅú

本製品~ÉÏンÐüùû²¿ËÅú�1ĆüÆûþûą²û~冒頭部{記載�¼vい~�2

交換部品

ñO~÷�ĆüÆ自身{¸»交換|ÿ能z MSO58LP型~部品²示�vい~�2機器内{�ĆüÆ|交換w}
»部品�あº~�³2

MSO58LP型~設置xÜ全性{関�»þûą²û 19



÷ 4 : 交換部品Ð´²ÀùĀ
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表 1 : 交換部品リスト

´ン÷ó¿
É番号

当社部品番号 数量 ]称x®明

1 407-6088-xx 2 öùÁóø1前面1ùó¿ûþ¶ンø1ùó¿û´Ąüÿ2UĀ
2 211-1682-xx 14 ýÈ110-32 X 5/16üÏンûøóù1½ăó÷1黒
3 407-6089-xx 2 öùÁóø1後部1ùó¿ûþ¶ンø1ÇăüÇ側

4 407-6090-xx 2 öùÁóø1後部1ùó¿ûþ¶ンø1ùó¿側

5 020-3180-xx 1 ùンÑ変換½óøÿº÷Çćúûû²¿ËÅúĀ

N÷{�z�2

A0 1 X米ß様電源÷ùÀÿ115V160HzĀ
A1 1 ĆûĀüÅû欧州ß様電源÷ùÀÿ220V150HzĀ
A2 1 ´¾úÉß様電源÷ùÀÿ240V150HzĀ
A3 1 ºüÉøùú²ß様電源÷ùÀÿ240V150HzĀ
A5 1 É´Éß様電源÷ùÀÿ220V150HzĀ
A6 1 日本ß様電源÷ùÀÿ100V150/60HzĀ
A10 1 中国ß様電源÷ùÀÿ50HzĀ
A11 1 ´ンùß様電源÷ùÀÿ50HzĀ
A12 1 öùÈûß様電源÷ùÀÿ60HzĀ

 āンöúンÉ
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EMC1Ü全1環境{関�»適合性

適合性{関�»情報

�~Ë¿Çćンw�1本製品|適合�vい» EMC基準1Ü全基準1z¸s環境基準{tいv®明�~�2�~製
品�^門家z¸s訓練²Ø��人~�|使用�»�x²目的x�vい~�2家庭w~使用や子供{¸»使用{
対応�v設計�¼vい~�³2

ñO~適合性{関�»�質問�1ñO~Q所Ü{1直接z問い合わ�い����x�w}~�：

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC適合性

欧州 EMC指ð
指ð 2014/30/EU電磁環境両立性{適合�~�2>Official Journal of the European Communities?{記載~ñO~基準
{準â�~�2

EN 61326-11EN 61326-2-1. 測Û1v御1z¸s実験用途~電子機器²対象x�» EMC基準：  1 2 3 4

■ CISPR 11：Àûü÷ 11¿ùÉ A1放射z¸s伝^¸ÿóÇćン

■ IEC 61000-4-2：静電気放電´ÿąûö³

■ IEC 61000-4-3：RF電磁界´ÿąûö³  5

■ IEC 61000-4-4：電流高速øùンÌンø／ĀüÉøû´ÿąûö³

■ IEC 61000-4-5：電力線ÅüÈû´ÿąûö³

■ IEC 61000-4-6：伝^ RF ´ÿąûö³

■ IEC 61000-4-11：電wPOx瞬時停電´ÿąûö³

EN 61000-3-2. AC電源ù´ン高調波¸ÿóÇćン

EN 61000-3-3. 電w~変W1変動1z¸sõúó»

1 本製品�Q居区域ñ外w~使用²目的x���~w�2Q居区域w使用�»x1電磁~o~原因xz»�x|あº~�2
2 本製品²öÉø対象{接続��状態w�1�~規格|要求�»üùû²超え»¸ÿóÇćン|~生�»ÿ能性|あº~�2
3 機器{öÉøûúüù~��öÉøû÷ýüö|接続�¼vい»x}{�1�¼¹~úüù／÷ýüö{電磁~o|»ó÷úンÀ�¼»��1��{記載
�¼vい»標準{¸º規Û�¼�´ÿąûö³要件²���»x�限º~�³2電磁~o{¸»影響²Ā_限{抑え»{�1信号~非Çüûù部V
x対応�»úÏüンûúüù~間~ûü÷領域²Ā_{�~�2~�1電波 害~~生源{¹w}»��遠��»¸う{�~�2ûü÷領域²少z��
»��~効率的z方法�1非Çüûù部V~öÉøûúüù²ô´Éøú²{�»�xw�2÷ýüö~場合1ÀùンùûúÏüンûúüù²w}»��短�
�1÷ýüö本体{近u�»¸う{�~�2}う��処置²効率的{行え»¸う{1÷ýüö{¸sv�1²¿ËÅúx�v÷ýüöûÑó÷û²Ð÷Ï|
提供�¼vい»機種�あº~�2い�¼~場合�1使用�»÷ýüö~��úüù~×扱®明書²十V{¯�¸う{�v���い2

4 ��{挙��各種 EMC規格{確実{準â�»{�1ÁüöûûÇüûùxÃý¿ÏûÇ·û²P´ンôüÐンÉw接続w}»¸う{1高品質zÇüû
ù²持t´ンÏõ·üÉûÁüöû|必要w�2

5 IEC 61000-4-3{規Û~ RF電磁界／伝^性 RF~~o²Ø��場合1本機器� 10mV/div～1V/divw 0.1divñO~波形変Oz¸s 0.2divñO~ p-p
þ´Ê増加²生�~�2
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EMC適合性
ß様表~記載製品x共{使用��場合�1指ð 2014/30/EU電磁環境両立性{適合�~�2記載製品~}開
EMCß様²参照�v���い2}~à~製品x共{使用��場合1指ð{適合�zいÿ能性|あº~�2

ºüÉøùú²／ûąüÈüùンù適合ü言―EMC
ACMA{従い1l~規格{準â�»�xw Radiocommunications Act~ EMC条�{適合�vい~�2

■ EN 61326-1z¸s EN 61326-2-1：Àûü÷ 11¿ùÉ A1放射z¸s伝^¸ÿóÇćン

Ü全性

�~Ë¿Çćンw�1製品|適合�vい»Ü全規格z¸s}~à~基準{tいv®明�~�2

EU適合ü言 - P電w
>Official Journal of the European Union?{úÉø�¼vい»l~ß様{準â�~�2

P電w指ð 2014/35/EU：

■ EN 61010-1： 測Û1v御1z¸s実験用途~電子装置{対�»Ü全基準 – 第 1部：一般要件2

■ EN 61010-2-030： 測Û1v御1z¸s実験用途~電子装置{対�»Ü全基準 – 第 2-030部：試験回路z¸s
測Û回路~特Û要求事�2

米国~国家認Û試験機関~úÉø

■ UL 61010-1： 測Û1v御1z¸s実験用途~電子装置{対�»Ü全基準 – 第 1部：一般要件2

■ UL 61010-2-030： 測Û1v御1z¸s実験用途~電子装置{対�»Ü全基準 – 第 2-030部：試験回路z¸s
測Û回路~特Û要求事�2

»úÐ規格

■ CAN/CSA-C22.2 No. 61010-1： 測Û1v御1z¸s実験用途~電子装置{対�»Ü全基準 – 第 1部：一般要
件2

■ CAN/CSA-C22.2 No. 61010-2-030： 測Û1v御1z¸s実験用途~電子装置{対�»Ü全基準 – 第 2-030部：
試験回路z¸s測Û回路~特Û要求事�2

}~à~基準{対�»適合性

■ IEC 61010-1： 測Û1v御1z¸s実験用途~電子装置{対�»Ü全基準 – 第 1部：一般要件2

■ IEC 61010-2-030： 測Û1v御1z¸s実験用途~電子装置{対�»Ü全基準 – 第 2-030部：試験回路z¸s
測Û回路~特Û要求事�2

機器~種類

öÉø機器z¸s計測機器2

Ü全¿ùÉ

¿ùÉ 1 － ²üÉ付}製品

EMC1Ü全1環境{関�»適合性  
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汚÷度{tいv

製品内部z¸s}~周辺w~生�»ÿ能性|あ»汚÷度~尺度w�2通常1製品~内部環境�外部環境x\
�規Û|適用�¼»�~x�z�¼~�2製品�1}~製品{指Û�¼vい»環境w~�使用�v���い2

■ 汚÷度 1：汚÷z�1~��乾燥��非伝^性~汚÷~�|~生�~�2�~»öÄú~製品�1通常1被包
性1密]性~あ»�~{1¿úüンûûüĀw~使用²想Û���~w�2

■ 汚÷度 2：通常1乾燥��非^電性~汚÷~�|~生�~�2���1結露{¸sv一時的z^電性|~生
�»�x�~¼{あº~�2�¼�1標準的zºõ³Éや家庭内~環境{相当�~�2一時的z結露�製品非
動作時~�~生�~�2

■ 汚÷度 3：伝^性~あ»汚÷1~��結露~��{伝^性~あ»汚÷xz»乾燥��非伝^性~汚÷2�¼
¹�1温度1�度~い�¼�管理�¼vいzい_内環境{相当�~�2日Zや雨1風{対�»直接~曝露{
¹�保護�¼vい»領域w�2

■ 汚÷度 4：伝^性~あ»塵1雨1~��雪{¸º持続的{伝^性|生�vい»汚÷2�¼�一般的z_外環
境{相当�~�2

汚÷度

汚÷度 2ÿIEC 61010-1~Û義{¸»Ā注：乾燥��_内w~�使用w}~�2

IPÛ格
IP20ÿIEC 60529wÛ義Ā2

測Ûz¸s過電w»öÄú{tいv

本製品~測Û端子�1測Û�»電源電w{tいvl~ 1t~��複数~»öÄú{評価�¼~�ÿ製品やþû
ą²ûx~特Û~評価²参照Ā2

■ 測Û»öÄú II：P電w´ンÉøüüÇćン{直接接続�¼�回路w実施�»測Û用2

■ 測Û»öÄú III：建築物~_内配線w実施�»測Û

■ 測Û»öÄú IV：P電w電源²使用�v実施�»測Û

NOTE. 過電w»öÄúÛ格{ü当�»~�主電源回路~�w�2測Û»öÄúÛ格{ü当�»~�測Û回路~
�w�2製品内部~}~à~回路{�い�¼~Û格�ü当�~�³2

主電源過電w»öÄúÛ格

過電w»öÄú IIÿIEC 61010-1~Û義{¸»Ā

環境基準{対�»適合性

�~Ë¿Çćンw�本製品|環境{z¸ぼ�影響{tいv®明�~�2

有害物質{関�»規v

RoHS2指ð 2011/65/EU{適合2

 EMC1Ü全1環境{関�»適合性
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使用n�製品~処理方法

機器~��Ãンýüýンø²úÅ´¿û�»�{�1l~¼´ùù´ン²�Û�v���い2

機器~úÅ´¿û. 本製品~製造{�天然資源|使用�¼vい~�2�~製品{�1環境~��人体{有害xz
»ÿ能性~あ»物質|含~¼vい»��1製品²廃棄�»�{�適W{処理�»必要|あº~�2有害物質~
放出²防~1天然資源~使用²減¹���1本製品~部材~再利用xúÅ´¿û~徹底{�協力���い2

�~þü¿�1本製品| WEEEÿ廃棄電気û電子機器Āz¸sĀóöú{関�»指ð 2012/19/ECz¸
s 2006/66/EC{基u}1EU~諸要件{準â�vい»�x²示�vい~�2úÅ´¿û方法{tいv
�1当社~ Web Å´ø~ÅüóÉûË¿Çćンÿwww.tek.com/productrecyclingĀ²参照�v���い2

Āóöú~úÅ´¿û

本製品{�_型~úÑ¶ĀûāÏûûüÏン電池|内蔵�¼vい~�2使用n�電池~廃棄{tいv�1zQ~
い~地域~所轄官庁{z尋}���い2

過塩素酸塩~×º扱い. 本製品{� CR úÑ¶Ā電池|搭載�¼vい~�2CR úÑ¶Ā電池�»úõ¹ûû²州
法{¸º過塩素酸塩材x�v規Û�¼1特wz×º扱い|求�¹¼vい~�2ý細{tいv�1www.dtsc.ca.gov/
hazardouswaste/perchlorate²参照�v���い2

Āóöú~輸送

本機{含~¼»_型úÑ¶Ā一lüÏン電池~úÑ¶Ā金属~含有量�Ëûあ�º 1g²超えvい~�³2~
�1āü»{¸ºËû~種類|表記�¼vzº1UN Manual of Tests and Criteria Part III, Sub-section 38.3~ü当�»要
件²���vい~�2úÑ¶ĀûĀóöú~輸送{��v�1}~輸送手段{関わ¹�1製品²~送�»前{1再
āóÁüÈWやùùû~張ÿえzy1zû様~ù包方法{適用�¼»輸送要件{tいv1運送業者{確認�»
¸う{�v���い2

EMC1Ü全1環境{関�»適合性 
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保修

泰克保证，本产品自发¯之日起O (3) �内O会ûĀ材料和ý艺缺陷2如果在保修期内证明任何m类产品有缺陷，泰
克将会选éü缺陷产品ß行维修或更换，O收部þ和人ý费用，或者更换有缺陷的产品2泰克用作保修用途的部þ1

模块和ÿï品ÿ能是全新的，或者经修理x有相`于新产品的性能2�有更换的部þ1模块和产品将成~泰克的¯

产2

~获得本保修��û的服á，客户必û在保修期内向泰克通ç缺陷，并~服á的履行做û�`Ü排2客户Þ负°包

装缺陷产品并托ß到泰克指定的维修中心，\时预付ß费2如果产品要ß�到泰克维修中心�在ÿ内的地ù，泰克

Þ支付向客户�返产品的费用2如果产品�返到任何w他地ù，客户Þ负°支付�有的ß费1关税1税金及任何w

他费用2

本保修O�用于由于使用O`或者维æ保{O`或O足� 成的任何缺陷1故障或损坏2泰克在m保修Q无义á提
供ñQ服áÿa) 修理由非泰克服áï表人员ü产品ß行Ü装1修理或维æ�üô的损坏Āb) 修理由于使用O`或PO
|容的¿备â接 成的损坏Āc) 修理由于使用非泰克提供的电源而 成的任何损坏或故障Ād) 维修已改ú或者Pw他
产品集成的产品ÿ如果à种改ú或集成会增à产品维修的时间或难þĀ2

本保修由泰克�ü本产品而¬立，用于ÿï任何w他明示或÷示的保证2泰克及w供Þ商拒ÿü��性或用于特殊

目的�用性作û任何÷示的保证2ü于áà本保修的情况，泰克负°修理或更换缺陷产品是提供给客户的�一和全

部补救ê施2无论泰克及w供Þ商是否被预Y告知ÿ能发生任何间接1特殊1偶然或必然的损坏，泰克及w供Þ商

üàß损坏概O负°2
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重要Ü全信o

本手Ý包�用户必û遵Û的信o和警告，ñ确保Ü全操作并保证产品Ü全2

若要Ü全执行关于本产品的服á，请参阅常规Ü全概要^面的服áÜ全概要2

常规Ü全概要

请á必按照规定使用产品2ðþ阅üQ列Ü全性预¶ê施，ñ避免人身伤害，并¶k损坏本产品或P本产品

â接的任何产品2认真阅ü�有说明2保留àß说明ñ供日^参考2

Þ�据`地和相Þÿ家法规的要求使用本产品2

~了l确1Ü全地操作产品，除本手Ý规定的Ü全性预¶ê施外，ß必û遵Û}认的Ü全规程2

产品仅限经过ÿ¯的人员使用2

只有了解相关t险的合格人员才能ß行开盖维修1保{或调整2

使用前，请á必检查产品是否来自已知来源，ñ确保l确操作2

本产品O�用于检测t险电压2

如果`在t险带电ü体暴露，请使用个人保æ装备ñ¶电ü和电弧爆ø伤害2

使用本产品时，您ÿ能需要使用一套大型系统的w他部þ2有关操作à类系统的警告和注意Ïù，请阅üw

他器þ手Ý的Ü全性部V2

将本¿备集成到某系统时，ï系统的Ü全性由系统的组装者负°2

避免火灾或人身伤害

使用合�的电源线ÿ 只能使用本产品_用并经�在ÿ家/地|认证的电源线2O要使用~w他产品提供的电
源线2

将产品接地ÿ 本产品通过电源线的接地ü线接地2~避免电ü，必û将接地ü线P大地相â2在ü本产品的
输入端或输û端ß行â接之前，请á必将本产品l确接地2O要W断电源线的接地â接2

断开电源ÿ 电源线ÿñ使产品断开电源2请参阅有关O置的说明2请勿将¿备�在难ñ操作电源线的O置Ā
必û保证用户ÿñ随时操作电源线，ñ便需要时快�断开â接2

l确â接并l确断开â接ÿ 探头或测试ü线â接到电压源时请勿插拔2仅使用产品Ö带的或 Tektronix 指明�
合产品使用的ÿ缘电压探头1测试ü线和�配器2

遵Û�有Ā端�定值ÿ ~避免火灾或电üt险，请遵Û产品P的�有�定值和标记说明2在â接产品之前，
请Y查看产品手Ý，了解�定值的ðþ信o2请勿超过产品1探头或Öþ中各器þ中�定值ĀP者的测量类

别 (CAT) �定值和电压或电流�定值2在使用 1:1 测试ü线时要小心，因~探头端部电压会直接传输到产品
P2

ü任何Ā端ÿ包括}rĀ端Ā施à的电势O要超过ïĀ端的Ā大�定值2

请勿将}rĀ端的电压浮ú到ïĀ端的�定电压ñP2

本产品的测量端子�定值O�用于â接到^电或 II1III 或 IV 类型电路2

请勿开盖操作ÿ 请勿在外盖或面板拆除或机壳打开的状aQ操作本产品2ÿ能有t险电压暴露2

à离外露电路ÿ 电源接通^请勿接触外露的接头和器þ2
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`疑产品ûĀ故障时，请勿ß行操作ÿ 如果`疑本产品已损坏，请让合格的维修人员ß行检查2

产品损坏时请勿使用2本产品损坏或ß行错误时请勿使用2如果`疑产品`在Ü全þ ，请关ý产品并断开

电源线2在产品P做清晰标记ñ¶wÞ被使用2

在使用之前，请检查电压探头1测试ü线和Öþ是否有机械损坏，如损坏则予ñ更换2如果探头或测试ü线

损坏1金属外露或ûĀ磨损迹象，请勿使用2

在使用之前请Y检查产品外表面2查看是否有裂纹或缺失部þ2

仅使用规定的ÿ换部þ2

请勿在潮湿ÿ境Q操作ÿ 请注意，如果某个单元Ð冷处移到ö处，则ÿ能产生冷凝水2

请勿在易燃易爆的ÿ境Q操作ÿ

请保持产品表面清洁~燥ÿ 清洁本产品前，请移除输入信÷2

请�`通风ÿ 有关如何Ü装产品使w保持�`通风的ðþ信o，请参阅手Ý中的Ü装说明2

�提供的ÿ槽和开口用于通风，O得遮盖或阻挡2请勿将物体�ß任何开口2

提供Ü全的ý作ÿ境ÿ 始Ā将产品�在方便查看显示器和指示器的地方2

避免ü键盘1指�和按钮盘使用O`或长时间使用2键盘或指�使用O`或长时间使用ÿ能üôo重损伤2

请确保ý作|符合�用的人体ý程学标准2请咨询人体ý程学_家，ñ避免Þ激损伤2

抬起或搬ß产品时请小心谨慎2本产品带有便于抬起和搬ß的手柄2

警告ÿ 本产品较重2~了降P人身伤害或¿备损坏的风险，在抬起或搬ß产品时请û求帮û2

仅限使用~本产品指定的泰克机架Ü装硬þ2

探头和测试ü线

â接探头或测试ü线之前，请将电源线Ð电源â接器â接到l确接地的电源插ÿ2

请将手指�在探头P保æ屏障1手指¶æ装置或触Ê指示器的^面2

拔掉�有O用的探头1测试ü线和Öþ2

仅使用l确的测量类别 (CAT)1电压1温þ1海拔高þ和电流�定的探头1测试ü线和�配器ß行测量2

小心高电压ÿ 了解您l在使用的探头的�定电压，请O要超ûàß�定值2重要的是知道并理解n个�定
值ÿ

■ 探头端部到探头参考ü线的Ā大测量电压

■ 探头参考ü线到大地的Ā大浮ú电压

àn个�定电压×决于探头和您的Þ用2请参阅手Ý的<�术规格=部V了解更多ð情2

警告ÿ ~¶k电ü，请O要超û示波器输入 BNC â接器1探头端部或探头参考ü线的Ā大测量电压或Ā大
浮ú电压2

重要Ü全信o  
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l确â接并l确断开â接ÿ 将探头â接到被测电路之前，Y将探头输û端â接到测量产品2在â接探头输入
端之前，请Y将探头参考ü线P被测电路â接2将探头P测量产品断开之前，请Y将探头输入端及探头参考

ü线P被测电路断开2

只能将探头参考ü线â接到大地2

检查探头和Öþÿ 在每k使用之前，请检查探头和Öþ是否损坏ÿ探头本体1Öþ1电缆外壳等的割裂1破
损1缺陷Ā2如果损坏，请勿使用2

使用ñ地~参考的示波器ÿ 在使用ñ地~参考的示波器时，O要将m探头的参考引线浮地2参考引线必ûâ
接到大地电势 (0 V)2

浮ú测量使用ÿ O要将m探头的参考引线浮ú到�定浮ú电压之P2

维修Ü全概要

维修Ü全概要部V包�Ü全执行维修�需的w他信o2只有合格人员才能执行维修程序2在执行任何维修
程序之前，请阅üm维修Ü全概要和常规Ü全概要2

避免电üÿ 接通电源时，请勿触摸外露的â接2

请勿单þß行维修ÿ 除非Ā场有他人ÿñ提供急救和复苏ê施，否则请勿ü本产品ß行内部维修或调整2

断开电源ÿ ~避免电ü，请Y关ý仪器电源并断开P^电电源的电源线，然^Þ拆Q外盖或面板，或者打开
机壳ñß行维修2

带电维修时要小心操作ÿ 本产品中ÿ能`在t险电压或电流2在卸Q保æ面板，ß行焊接或更换元þ之前，
请Y断开电源，卸Q电lÿ如�用Ā并断开测试ü线2

维修^验证Ü全性ÿ 请á必在维修^重新检查接地â续性和^电介电强þ2

手Ý中的术语

本手Ý中ÿ能ûĀàß术语ÿ

警告ÿ <警告=声明指ûÿ能会 成人身伤害或t及生命Ü全的情况或操作2

注意ÿ <注意=声明指ûÿ能ü本产品或w他¯产 成损坏的情况或操作2

 重要Ü全信o

MSO58LP Ü装和Ü全手Ý v



产品P的术语

产品Pÿ能ûĀàß术语ÿ

■ DANGERÿt险Ā表示您看到ï标记时ÿ直接üô人身伤害的t险2

■ WARNINGÿ警告Ā表示您看到ï标记时O会直接üô人身伤害的t险2

■ CAUTIONÿ注意Ā表示ÿ能会ü本产品或w他¯产带来的t险2

产品P的符÷

产品P标示m符÷时，请确保查阅手Ý，ñ了解潜在t险的类别ñ及避免àßt险需采×的ê施2

ÿm符÷ßÿ能用于指引用户参阅手Ý中的�定值信o2Ā

产品Pÿ能ûĀñQ符÷ÿ

重要Ü全信o  
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前言

本手Ý提供产品Ü全和一ô性信o，说明示波器â接和通电方法并介绍仪器ß能1çþ和Ā本操作2有关更

多ðþ信o，请参阅产品 Helpÿ帮ûĀ文þ2

�要ß能

l迎使用 5 系列紧凑型 MSO25 系列紧凑型 MSO (MSO58LP) 是一款 8 通道示波器，在世界P首Y采用了Ā于
FlexChannel® 的输入，让您ÿñ�ü几乎�有¿«高效经o地执行混合信÷调试2

■ O带显示器的紧凑型仪器随时ÿÜ装在 2U 机架空间

■ 1 GHz 带宽

■ 8 条通道，采用 FlexChannel® 输入

■ 各 FlexChannel 输入x有n种ß能，供您â接模拟探头ÿTekVPI® 或 BNCĀ或 8 通道数_探头ÿTLP058
FlexChannel 逻 探头Ā

■ Ā高 6.25 GS/s 采�率

■ �有通道P的记录长þ均~ 125 M ù

■ Ā大波形捕获�率 500,000 个波形/秒

■ FastFrame™ V段内`采集使用多个触发Ïþ，ñ高采�率捕获广发有趣Ïþ并节þ采集内`

■ üÿ采集的数学波形1参考和总线的数量没有¿置限制ÿ波形数量×决于ÿ用的系统内`Ā

■ 集成选þ包括 50 MHz 任意函数发生器 (AFG) ñ及数_电压表 (DVM) 和触发频率«数器

■ 高ÿ串行总线触发和V析选ù确保您能够在行`标准总线P执行解码和触发操作2请参阅串行总线和触
发选ù Helpÿ帮ûĀ� 

■ ß率和øú选ù提供�外的测量和V析ß能2请参阅高ÿß率V析和高ÿøúV析选ù Helpÿ帮ûĀ�
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相关文档

请使用相关文档了解仪器ß能的更多信o1如何à程编程或操作仪器1了解ý作原理1更换ÿ能ûĀ故障的
模块ñ及执行w他任á2

MSO58LP 文档

需了解的信o 使用m文档

如何使用仪器ß能 5 系列 MSO MSO58LP Ü装和Ü全手Ýÿ本文档，泰克部þ编÷ 071-3568-xxĀĀ仪器
标配Öþ2包�英文1日文和简体中文语言的单个文档2俄语x本ÿñÐ泰克网
站Q载ÿ泰克部þ编÷ 077-1404-xxĀ
5 系列和 6 系列 MSO 帮ûÿ泰克部þ编÷ 077-1303-xxĀ仪器 Helpÿ帮ûĀ的ÿ打
sx本ĀÿÐ www.tektronix.com/downloads 获×Ā

如何à程ç制仪器 5 系列和 6 系列 MSO 程序员手Ýÿ泰克部þ编÷ 077-1305-xxĀÿÐ www.tek.com/
downloads 获×Ā

仪器�术规格ñ及验证仪
器是否符合�术规格的流
程

5 系列 MSO MSO541MSO561MSO581MSO58LP �术规格和性能验证�术参考ÿ泰
克部þ编÷ 077-1306-xxĀÿÐ www.tek.com/downloads 获×Ā

使用 TLP058 逻 探头 TLP058 FlexChannel® 逻 探头说明ÿ泰克部þ编÷ 071-3515-xxĀÿÐ www.tek.com/
downloads 获×Ā

转换仪器ñ便在ý作ĀP
使用

MSO58LP ý作Ā转换套þ说明ÿ泰克部þ编÷ 075-1102-xxĀÿÐ www.tek.com/
downloads 获×Ā

前言  
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Ü装仪器

检查Ö带的Öþ

确保您已收到�有¬购物品2如果有任何缺失，请联系泰克客户支持2在X美地|，请è打 1-800-833-92002
w他地|用户请Àþ www.tek.com 查~`地的联系信o2

请�ü仪器随Ö的包装清单，ñ确认是否收到�有标配Öþ和¬购物品2如果您购买了û厂Ü装的选þÿ如

串行总线和触发选þ或ß率测量选þĀ，请ùü Helpÿ帮ûĀ> Aboutÿ关于Āñ确认选þ已在 Installed Options
ÿ已Ü装选þĀ表中列û2

MSO58LP 标配Öþ

ù目 数量 泰克部þ编÷

5 系列 MSO MSO58LP Ü装和Ü全手Ý 1 071-3568-xx

电源线 1 ×决于|域

校准证书 1 O�用

û厂Ü装许ÿ的ç告 1 O�用

操作要求

请�据操作温þ1电源1海拔高þ和信÷输入电压范围要求使用示波器，ñ提供Ā准确的测量并确保仪器操

作Ü全2

ÿ境要求

特性 说明

ý作温þ 0℃ ó +50℃ÿ+32℉ ó +122℉Ā
~确保l常散热，请O要在仪器n侧 2 英ûÿ51 毫米Ā范围内堆�物
品2

ý作湿þ 在O高于 +40 °C (+104 °F) 时，相ü湿þ~ 5% 到 90% (% RH)，无冷凝2
在 +40℃ ó +50℃ÿ+104 °F ó +122℉Ā时，相ü湿þ~ 5% ó 55%，无冷
凝2

ý作海拔高þ Ā高 3,000 米ÿ9,842 英尺Ā
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电源要求

特性 说明

电源电压 100 V - 240 VAC RMS，±10%，单相
电源频率 50/60 Hz，100-240 V

400 Hz，115 V
ß耗 �有型÷ÿĀ高 400 W

输入信÷要求

将输入信÷ç制在允许的限制范围内，ñ确保Ā精确的测量并¶k损坏模拟或数_探头或仪器2

确保输入信÷满足ñQ要求2

输入 说明

模拟输入通道，1 M Ω ¿置，BNC 提供Ā大
输入电压

300 VRMS
测量类别 II

模拟输入通道，50 Ω ¿置，BNC 提供Ā大
输入电压

5 VRMS

数_输入通道，数_输入提供Ā大输入电

压

遵照探头�定值
TLP058Ā±42 VP

Ref In BNC 提供Ā大输入电压ÿ^面板Ā 7 VPP

辅û触发输入 ±5 VRMS

在机架中Ü装仪器

使用àß仪器在标准 19" ¿备机架中Ü装 MSO58LP2

MSO58LP 配有装在ß盘P的机架托架五金þ2使用仪器随Ö包中的螺栓和垫圈将^机架支架Ü装到机架中2

要在ý作ĀP使用 MSO58LP，请购买并Ü装 MSO58LP ý作Ā转换包ÿ泰克部þ编÷ 020-3180-xxĀ2m包装有
ß盘支脚和把手，供您将仪器叠�在ý作ĀP2

请按照ñQn骤在机架中Ü装仪器ÿ
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警告ÿ ~了¶kØ伤，需要n人Ü装仪器2

1. 使用Ö带五金þ中的n�螺栓和垫w将一个^机架托架装在机架^部2用手ç紧2
 

 

2. 由n人扶Q仪器，Ð机架前部插入仪器，使ß盘机架托架插入^机架托架中2

3. 继续Ð前部è入，直ó仪器P机架的前部齐�2

4. 使用Ö带五金þ中的四�螺栓和垫w将仪器前部装在机架^部2用手ç紧ñ支撑仪器2

5. Ð机架^部，将第Ð个^机架托架滑到仪器ß盘机架托架P，直ó^机架托架P^机架齐�2

6. 使用Ö带五金þ中的n�螺栓和垫w将第Ð个^机架托架装在机架^部2用手ç紧2

7. 将�有螺栓çó 1.1 N·m2

8. 使用 5/16 英û扳手将Ö带的n�~角螺栓装在每侧的^机架P，ñ便�紧机架并¶k在拆Q前机架螺�
^无意拆Q仪器ÿ见QĀĀ2每侧r有四个螺栓O置ÿ如Ā�示Ā2将托架�紧螺栓çó 0.7 N·m2
 

 

9. �据需要，将电源线和电缆â接^ß盘2

机架Ü装说明结束2
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确保示波器Ü全ÿ将w�定Ā

将示波器�定到测试ý作Ā或¿备机架ñ¶k 成¯产损失2

将标准笔记本电脑Ü全�定到示波器^面板，ñ便将示波器固定到ý作Ā机架或w他O置2
 

 

接通示波器电源

使用mn骤将示波器â接到^电电源，然^打开和关ý示波器2请始Ā使用仪器Ö带的电源线将示波器â接

到交流电源2

前提条þÿ使用示波器Ö带的交流电源线2

1. 将Ö带的电源线â接到示波器电源â接器2

Ā 1: MSO58LP 电源线â接器和电源à机开关

2. 将电源线â接到合�的^电电源2

每`将交流电源线â接到^电供电电路并将仪器置于à机模式时，将会~电源和w他一ß电路板供电2

3. 按Q前面板电源按钮来打开和关ý仪器电源2

电源按钮�色指示仪器电源状aÿ

O亮 – 未提供交流电源

黄色 – à机模式

蓝色 – 已通电

4. 要Ð仪器P完全断开电源，请断开电源线2

Ü装仪器  
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确认示波器通过开机自检

开机自检将确认�有示波器模块在开机^是否l常ý作2

前提条þÿü于 MSO58LP，将显示器â接到^面板的视频输û端口并将鼠标â接ó USB 端口2

1. 接通示波器电源，然^等à，直óûĀ示波器屏幕2

2. Ðþ部菜单栏中选é Utilityÿ辅ûß能Ā> Self Testÿ自检Ā来打开 Self Testÿ自检Ā配置菜单2

3. 确认�有开机自检的状a均~ Passedÿ通过Ā2

如果一k或多k开机自检均显示 Failedÿ失败Āÿ

a. 重新接通示波器电源2

b. ùü Utilityÿ辅ûß能Ā> Self Testÿ自检Ā2如果一k或多k开机自检Ï显示 Failedÿ失败Ā，请联系
泰克客户支持2

â接探头

探头和电缆将示波器â接到您的被测¿备 (DUT)2使用能够Ā好{配您的信÷测量要求的探头2

Ā 2: 将探头â接 MSO58LP

将 TPP0500B1TPP10001TekVPI+1TekVPI 或w他支持的泰克模拟探头è入 FlexChannel â接器将wâ接2探头
完全到O^将会�到<咔=的声音，探头ý�即被�定2

TekVPI 探头自ú¿置ï探头的通道输入参数ÿ带宽1衰减1端接等Ā2如果探头包� Menuÿ菜单Ā按钮，按
Qï按钮ÿ打开屏幕P配置菜单2请按照有源探头提供的说明¿置参数ÿ自ú调零1消磁等Ā2
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â接 TLP058 FlexChannel 逻 探头或 TDP7700 系列 TriMode™ 探头ÿ

1. 将�定杆移ú到未�定O置，然^释�ñ将�定杆重置到中心O置2

2. 将探头插入 FlexChannel â接器，直到完全到O并�到�定机制发û<咔=的声音2

3. 将�定杆移ú到�定O置2状a灯Þ呈恒绿色2

4. 要断开 TLP058 探头，请将�定杆移ú到未�定O置并按Q，然^拉û探头2×Q探头时O要拉o排线2

将 BNC 探头或电缆è入通道 BNC 卡口â接器将wâ接，然^ú时�旋转�定机制直ó�定2

注意ÿ â接探头时O会自ú启用ÿ激活Āï通道2使用仪器çþ或编程接口启用通道并打开w配置菜单ñ确
认或更改探头或电缆¿置ÿ带宽1衰减1端接等Ā2

Ü装仪器  
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熟悉仪器

MSO58LP 前面板çþ和â接器
前面板用于接通或断开仪器电源1向探头或电缆传�信÷1â接外部触发输û信÷1插入 USB ¿备和Àþ探
头补偿信÷2
 

 

1. FlexChannel® 探头â接器ÿ

FlexChannel® â接器支持�有 TekVPI+ 和 TekVPI 测量探头1BNC 无源探头1TLP058 FlexChannel® 逻 探头和
BNC 电缆2â接大多数探头时，只需将wè入â接器直到完全到O并�到<咔=的声音2请参阅 â接探
头第 5ý

2. LAN 状a LEDÿ

显示网þâ接和活ú状aÿ

■ O亮 - 仪器未通电

■ 绿色 - 网þâ接l常

■ 红色 - 网þâ接ûĀ故障或未â接
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3. 探头补偿â接器ÿ
 

 

探头补偿â接提供了一个接地â接器和 1kHz 方形波源，ÿ用于调节无源探头的高频率响Þÿ探头补偿Ā2
示波器使用ï信÷自ú补偿支持的探头2请参阅 补偿 TPP0500B 或 TPP1000 探头第13ý2

您也ÿñ使用接地â接器â接¶静电手ÿ，在搬ß或探测 DUT 时，减少静电损坏 (ESD) 的机会2

4. USB �ç端口ÿ

USB 端口O于前面板右Q角P2â接ÿ保`或调û数据ÿ如仪器固þ更新1波形1¿置和屏幕捕获Ā的
U 盘，或â接鼠标或键盘等外围¿备2

5. Aux Trig 触发输入â接器ÿ

用于â接外部触发输入信÷的 SMA â接器2配合使用 AUX In 触发信÷P Edgeÿ边沿Ā触发模式2

6. 采集状a LEDÿ

显示仪器触发/采集状aÿ

■ 绿色 - 触发

■ 黄色 - 启ú未触发

■ 红色 - 采集停k

7. Power On/Standbyÿ开机/à机Ā按钮ÿ

接通和断开仪器电源2电源按钮�色指示仪器电源状aÿ

■ O亮 – 未提供交流电源

■ 黄色 – à机模式

■ 蓝色 – 已通电

熟悉仪器  
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^面板â接

^面板â接ÿ~示波器供电并提供网þ1USB ¿备1视频1参考信÷和 AFG 输û的â接器2
 

 

1. 电源线â接器2只能使用本产品_用并经�在ÿ家/地|认证的电源线2

2. Ref In 用于将高精þ 10MHz 参考信÷â接到示波器，ñ提高测量准确þ2

3. AUX Out ÿü触发Ïþ生成跳Ù，输û 10 MHz 参考信÷或Ð AFG 输û\n信÷2

4. AFG Out 是选配任意函数发生器 (AFG) 的信÷输û2

5. 视频输ûÿ显示端口1VGA 和 DVI-DĀ用于â接外部÷视器或÷影仪来显示示波器屏幕2

6. USB ¿备端口用于â接到一Ā PC，ñ使用 USBTMC 协°à程ç制示波器2

7. USB �ç端口用于â接 USB 内`¿备1键盘或鼠标2

8. LAN â接器 (RJ-45) 将示波器â接到 10/100/1000 Base-T 局域网2

9. Ü全�â接器用于使用标配 PC/笔记本电脑�电缆将示波器固定到ý作Ā或w他O置2

Ā形用户界面

尽管_~编程ç制¿«，MSO58LP 的Ā形用户界面\�包括产品帮û� 2您ÿñ通过ñQ方法ÀþĀ形界
面ÿ将显示器和鼠标â接仪器或使用pÉ器Àþ联网仪器2

将V辨率ó少~ 1,920 水�像素 × 1,080 垂直像素ÿ高清Ā的显示器ÿ标准或触摸屏Āâ接^面板P的视频输
ûâ接器2

要ÐpÉ器Àþ，请在pÉ器地址栏中输入仪器的 IP 地址，ñ打开仪器的pÉ器l迎ý面2单ü屏幕þ侧的
仪器ç制ÿ仪器ç制Ā(e*Scope®) 链接打开Ā形界面2

将鼠标ÿUSB 线Ā或鼠标à密狗ÿ供 USB 无线鼠标使用Āâ接任一 USB 端口2

有关理解和使用Ā形用户界面的ð情，请参阅 5 系列 MSOÿMSO541MSO561MSO58ĀÜ装和Ü全手Ýÿ泰克
部þ编÷ 071-3514-xxĀÿñÐ www.tek.com/product-support Q载2Ā

 熟悉仪器
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配置仪器

¿置时|和时钟ü数格式

将时|¿置~您�在|域，ñ便~已保`的文þ标记l确的日期和时间信o2您ßÿñ¿置时间格式ÿ12 或
24 小时制Ā2

要在 MSO58LP PÀþ用户界面，请将显示器â接仪器^部的视频端口并将鼠标â接任一 USB �ç端口2如
果à程显示器支持触摸操作，则无需â接鼠标2您也ÿñ在 web pÉ器中输入仪器的 IP 地址来à程Àþ联网
仪器的用户界面2

要à程¿置mçþ或在 MSO58LP P执行m任á，请参阅示波器程序员手Ýÿ泰克部þ编÷~ 077-1305-xxĀ了
解需使用的l确命ð2

1. ßü Date/Timeÿ日期/时间Ā标记ÿ屏幕右Q方Ā打开配置菜单2
 

 

2. 要关ý在屏幕P显示日期和时间，请将 Displayÿ显示Ā按钮ù按~ Offÿ关Ā2
要Þk打开日期/时间显示，请ßü显示日期/时间标记�在的空白|域打开配置菜单，然^，将 Display
ÿ显示Ā按钮¿置~ Onÿ开Ā2

3. 选é时间格式ÿ12 Hourÿ12 小时制Ā或 24 Hourÿ24 小时制ĀĀ2

4. ùü Time Zoneÿ时|Ā_段并选é�用您�在O置的时|2

5. ùü菜单外任何地方将w关ý2

Q载并Ü装Ā新固þ

Ü装Ā新固þ将有û于确保示波器测量的Ā大精确þ2

要在 MSO58LP PÀþ用户界面，请将显示器â接仪器^部的视频端口并将鼠标â接任一 USB �ç端口2如
果à程显示器支持触摸操作，则无需â接鼠标2您也ÿñ在 web pÉ器中输入仪器的 IP 地址来à程Àþ联网
仪器的用户界面2
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Ð U 盘更新示波器固þ
前提条þÿ确定示波器P已Ü装的`前固þx本ÿHelpÿ帮ûĀ> Aboutÿ关于ĀĀ

1. 打开 PC 中的 Web pÉ器并Àþ www.tek.com/product-support2

2. 在搜索_段中输入示波器型÷并单ü Goÿ前往Ā2

3. 向Q滚ú屏幕并单ü Softwareÿ软þĀ选ù卡2

4. 如果列û的ÿ用固þx本ÿWindows 或非 Windows x本Ā高于示波器中的x本，请选ém文þ并Q载到您的
PC 中2

5. 请按照已Q载固þ随Ö的Ü装说明创建固þÜ装文þ2

6. 将固þÜ装文þ复制到 U 盘2

7. 将 U 盘插入任一示波器 USB �ç端口ÿ

a. 非 Windows 示波器将检测到�固þ文þ的 U 盘并开始Ü装过程2按照屏幕说明Ü装固þ2

b. ü于 Windows 示波器，在更新固þ前，请关ý TekScope 程序2打开 File Explorerÿ资源管理器Ā并ß行
U 盘中的固þ更新文þ，或者，将固þ更新文þ复制到桌面并Ð桌面ß行m文þ2按照屏幕说明Ü
装固þ2

注意ÿ 在示波器完成固þÜ装之前，请勿关ý示波器电源或移除 U 盘2示波器将在ÿñ关ý示波器时显
示一条消o2

8. 完成固þÜ装^，请移除 U 盘并重启示波器2
要确认固þÜ装，请执行ñQ操作ÿ

a. 在 Menuÿ菜单Ā栏中ùü Helpÿ帮ûĀ> Aboutÿ关于Ā2

b. 请确认屏幕P列û的固þx本÷P已Q载的x本相\2

ß行信÷路ß补偿 (SPC)
ñ常规间隔ß行 SPC，ñ获得Ā佳测量精þ2每`ÿ境ÿ室内Ā温þ改Ù超过 5℃ÿ9℉Ā时都Þ执行 SPC，
如果使用 5 mV/格或更P的垂直刻þ¿置，则Þ每周执行一k SPC2

要在 MSO58LP PÀþ用户界面，请将显示器â接仪器^部的视频端口并将鼠标â接任一 USB �ç端口2如
果à程显示器支持触摸操作，则无需â接鼠标2您也ÿñ在 web pÉ器中输入仪器的 IP 地址来à程Àþ联网
仪器的用户界面2

要à程¿置mçþ或在 MSO58LP P执行m任á，请参阅示波器程序员手Ýÿ泰克部þ编÷~ 077-1305-xxĀ了
解需使用的l确命ð2

信÷路ß补偿 (SPC) ÿ修l由于温þÙW和/或长期信÷路ß漂移引起的内部信÷路ß的直流电�误差2如
果无法ñ常规间隔ß行 SPC，ÿ能üô示波器O能达到P伏/格¿置时�保证的性能水�2

前提条þÿÐ前面板通道输入和^面板信÷â接器断开�有探头和电缆2

1. 打开示波器电源并预热ó少 20 V钟2

2. ùü Utilityÿ辅ûß能Ā> Calibrationÿ校准Ā2

配置仪器  
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3. ùü Run SPCÿß行 SPCĀ2SPC ß行时 SPC StatusÿSPC 状aĀü数显示 Runningÿl在ß行Ā2SPC 在
每个通道需要数V钟的ß行时间，因m请等à直到 SPC StatusÿSPC 状aĀ消o更改~ Passÿ通过Ā才能
重新â接探头和使用示波器2

注意ÿ 您ÿñ通过ùü Abort SPCÿĀk SPCĀ来Āk SPC 校准2àÿ能üô某ß通道未被补偿，Ð而
ÿ能 成测量结果O准确2如果Āk SPC，请确认ß行完 SPC n骤才能使用ï仪器ß行测量2

4. 请在完成 SPC 时关ý Calibrationÿ校准Ā配置ü话框2

5. 如果 SPC 失败，请记Q�有错误消o文_内容2确认已断开�有探头和电缆，然^重新ß行 SPC2如果
SPC Ï然失败，请联系泰克客户支持2

补偿 TPP0500B 或 TPP1000 探头
探头补偿将调整探头的高频率响Þ，ñ获得Ā佳波形捕获和测量精þ2示波器ÿ~无限数量的探头/通道组合
自ú测试和`储补偿值2

要在 MSO58LP PÀþ用户界面，请将显示器â接仪器^部的视频端口并将鼠标â接任一 USB �ç端口2如
果à程显示器支持触摸操作，则无需â接鼠标2您也ÿñ在 web pÉ器中输入仪器的 IP 地址来à程Àþ联网
仪器的用户界面2

要à程¿置mçþ或在 MSO58LP P执行m任á，请参阅示波器程序员手Ýÿ泰克部þ编÷~ 077-1305-xxĀ了
解需使用的l确命ð2

示波器ÿ`储每个探头/通道组合的补偿值，并在插入探头时自ú调û补偿值2探头补偿状a将显示在
Channelÿ通道Ā配置菜单的 Probe Setupÿ探头¿置Ā面板中2

■ 如果 Probe Compensation Statusÿ探头补偿状aĀ_段显示 Passÿ通过Ā，则探头已被补偿并ÿñ使用2

■ 如果 Probe Compensation Statusÿ探头补偿状aĀ_段显示 Defaultÿ默认Ā，则�â接的探头O会得到补偿
并需要ß行ï探头补偿程序2

■ 如果 Probe Compensation Statusÿ探头补偿状aĀ_段显示 Failÿ失败Ā，则ü�â接的探头ß行探头补偿
程序失败2重新â接探头并Þkß行探头补偿2

■ 如果面板中未显示探头补偿状a_段，则示波器无法`储ï探头的补偿值2请参阅示波器 Helpÿ帮ûĀ
ñ了解如何手ú补偿探头补偿ß能O支持的无源探头2

使用mn骤补偿â接到示波器时显示 Defaultÿ默认Ā状a的 TPP0500B1TPP1000 或w他支持的 TPP 系列探
头2

注意ÿ Default Setupÿ默认¿置ĀO会删除探头补偿值2û厂校准将删除`储的�有探头补偿值2

 配置仪器
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前提条þÿ示波器必û通电ó少 20 V钟ñP才能补偿探头2

1. 将支持的探头â接到输入通道2

2. 将探头端部和探头的接地ü线â接示波器右Q方的探头补偿Ā端ÿ如QĀ�示Ā2

Ā 3: MSO58LP P探头补偿â接器2

将探头端部â接 1kHz 信÷源并将接地夹接地2~获得Ā佳效果，请×Q�有探头端部Öþ并将探头端部
直接â接 1kHz â接器2

注意ÿ 每k仅将一个探头â接到探头补偿Ā端P2

3. 关ý�有通道2

4. 打开P探头â接的通道2

5. 在 MSO58LP P，Ð菜单栏中选é Fileÿ文þĀ> Autosetÿ自ú¿置Ā2屏幕显示一个方波2

6. ßü要补偿的通道的标记2

7. ùü Probe Setupÿ探头¿置Ā面板2

如果 Probe Compensation Statusÿ探头补偿状aĀ显示 Passÿ通过Ā，则探头已补偿ï通道2您ÿñ将探头
移ú到另一个通道并Ð第 1 n重新开始操作，或者将O\的探头â接到ï通道并Ð第 1 n开始操作2

如果 Probe Compensation Statusÿ探头补偿状aĀ显示 Defaultÿ默认Ā，请继续ïn骤2

8. ùü Compensate Probeÿ补偿探头Ā打开 Probe Compensationÿ探头补偿Āü话框2

9. ùü Compensate Probeÿ补偿探头Āß行探头补偿2

10. ` Probe Compensation Statusÿ探头补偿状aĀ显示 Passÿ通过Ā时，探头补偿将完成2Ð Probe Compÿ探
头补偿ĀĀ端拔Q探头端部和地线2

11. ~要补偿ï通道的�有支持的无源探头重复àßn骤2
12. 重复àßn骤补偿示波器w他通道�支持的探头2

注意ÿ ~获得Ā准确的测量，每`将探头â接到通道时，请打开 Probe Setupÿ探头¿置Ā面板并验证
Probe Compensation Statusÿ探头补偿状aĀ~ Passÿ通过Ā2

配置仪器  
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â接网þ (LAN)
â接网þÿñà程Àþ仪器2

要在 MSO58LP PÀþ用户界面，请将显示器â接仪器^部的视频端口并将鼠标â接任一 USB �ç端口2如
果à程显示器支持触摸操作，则无需â接鼠标2您也ÿñ在 web pÉ器中输入仪器的 IP 地址来à程Àþ联网
仪器的用户界面2

向您的网þ管理员获×�需的信oñâ接到网þÿIP 地址1网关 IP 地址1子网é码1DNS IP 地址等Ā2

1. 将示波器 LAN â接器的 CAT5 电缆â接到您的网þ2

2. 在菜单栏P选é Utilityÿ辅ûß能Ā> I/O 来打开 I/O 配置菜单2

3. 获×或输入网þ地址信oÿ

■ 如果网þ已经启用 DHCP ` IP 地址_段未显示地址，请ùü Autoÿ自úĀ获×m网þ的 IP 地址信
o2DHCP 模式~默认模式2

■ 如果网þ未启用 DHCP 或者您需要~ï仪器¿置永久ÿOÙĀ的 IP 地址，请ùü Manualÿ手úĀ并输入
IT 或系统管理员提供的 IP 地址及w他值2

4. ùü Test Connectionÿ测试â接Āñ验证ï网þâ接l常ý作2仪器成ßâ接网þ^，LAN 状aĀ标将Ù
~绿色2如果在â接网þ时遇到þ ，请联系系统管理员ñ获×帮û2

MSO58LP P的前面板 LAN 状a LED �色显示网þ状aÿ

■ O亮 - 仪器未通电

■ 绿色 - 网þâ接l常

■ 红色 - 网þâ接ûĀ故障或未â接

Ð Web pÉ器à程Àþ
您ÿñÐ Web pÉ器à程Àþ联网的标准仪器ÿ未ß行 Windows 10Āñ便在 PC P显示仪器用户界面2

m过程介绍如何à程Àþ标准仪器ÿ非 Windows 10Ā的 UI çþ和屏幕2要à程Àþ Windows 10 仪器的 UI çþ
和屏幕，请参阅

前提条þÿ

■ 示波器必ûâ接到 PC �â接的网þ并通过ï网þß行Àþ2请参阅 â接网þ (LAN)第 15ý

■ 您要Àþ的示波器的 IP 地址2要确定示波器的 IP 地址，请在示波器菜单栏中选é Utilityÿ辅ûß能Ā>
IO，然^在 LAN 面板中查看网þ¿置2

■ 您l在Àþ标准仪器ÿ未Ü装 Windows 操作系统选þĀ2

1. 在P示波器â接\一网þ的 PC 中打开网þpÉ器2

2. 只需在pÉ器的 URL 行输入示波器 IP 地址，并按Q Enterÿ回车Ā2例如ÿ135.62.88.1572pÉ器将搜索并
打开示波器的网ý2

 配置仪器
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3. 选é Instrument Controlÿ仪器ç制Ā(e*Scope®)2pÉ器显示仪器屏幕2

4. 使用鼠标选é网þpÉ器中显示的示波器çþ并Pw互ú2如果您的à程 PC 或笔记本电脑配有触摸屏
显示器，您ÿñ使用它Àþ示波器çþ2

注意ÿ 使用 e*Scope pÉ器Àþ仪器时，无法直接Ð PC 向仪器菜单_段中粘½文_ÿ例如路ß1IP 地址
信o等Ā2必û使用 e*Scope Þ用中提供的中间剪½板ß能2

使用ñQ几nÐâ接 e*Scope 的 PC 向仪器中复制文_ÿ

a. 打开P使用 e*Scope 的仪器的â接2

b. 在 PC P选é并复制文_2

c. 在 e*Scope 中，按 Ctrl-Alt-Shift 打开 Clipboardÿ剪½板Ā菜单2

d. 将文_粘½到剪½板_段中2
e. 按 Ctrl-Alt-Shift 关ýpÉ器 Clipboardÿ剪½板Ā菜单

f. 使用 e*Scope 打开要粘½内容的仪器菜单，然^，将Z标�在要粘½文_的_段中2

g. 按 Ctrl-Vÿ真l键盘或虚拟键盘ĀÐ e*Scope pÉ器剪½板向菜单_段中粘½文_2

h. 重复第  4.b nó第  4.g nñ便Ð PC 向仪器中复制和粘½w他文_2

配置仪器  
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操作Ā础

有关理解和使用Ā形用户界面来触发和获×波形并ß行测量的ð情，请参阅 5 系列 MSOÿMSO541MSO561
MSO58ĀÜ装和Ü全手Ýÿ泰克部þ编÷ 071-3514-xxĀ2

有关l确操作仪器�用的l确命ð，请参阅 5 系列 MSO MSO541MSO561MSO581MSO58LP 程序员手Ýÿ泰
克部þ编÷~ 077-1305-xxĀ2

àn本手Ý均ÿÐ www.tek.com/product-support Q载2
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维æ

本部V包�ü仪器ß行定期维æ�需的信o2

注意ÿ 除非要更换损坏的þ盖，否则请勿Ð仪器P卸Qþ盖2仪器内部没有ÿ由用户更换的部þ2将仪器返
回泰克ß行维修ÿ如果需要维修Ā2

清洁

使用ø软的~棉_清洁¿备外部2如果Ï有任何m垢，请用软_或棉签蘸 75% 的异_Ā酒精溶液清洁2使用
棉签清洁çþ和â接器周围的ÿ小空间2请勿使用任何ÿ能损坏1外壳1çþ1标记或标签或者ÿ能渗入外
壳的液体清洁剂或W学品2

性能验证间隔和调整

仪器内的电压Ā准和定时Ā准非常稳定，无需定期调整2

如果定期校准是¾组ÿ的要求之一，则一般规则是每操作 2000 个小时验证一k性能，如果仪器O经常使用，
则每�执行一k2请使用仪器的:规格和性能验证手Ý;ÿÿÐ www.www.tek.com/product-support 在线获×Ā中
�述的n骤2

如果仪器未通过:�术规格和性能验证;手Ý中的性能测试，则ÿ能需要ß行调整2只Þ由泰克维修中心执

行调整2有关泰克维修中心的联系信o，请参阅本手Ý标 ý面^的<泰克联系信o=2

ÿÿ换部þ列表

本部V包�仪器的ÿ更换部þ信o2使用相Þ部V中的列表，确定和¬购仪器的ÿ更换部þ2

标配Öþ

本手Ý开头Öà部V列û了àß产品的标配Öþ2

ÿ更换部þ

QĀ显示了 MSO58LP 中ÿ由用户更换的部þ2仪器内部没有ÿ由用户更换的部þ2
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表 1: ÿÿ换部þ列表

索引÷ 泰克部þ编÷ 数量 ]Ā和说明

1 407-6088-xx 2 支架，前部，机架Ü装，2U EAR
2 211-1682-xx 14 螺�，10-32 X 5/16 钮头，帽，黑色
3 407-6089-xx 2 支架，^部，机架Ü装，ß盘侧

4 407-6090-xx 2 支架，^ÿ，机架Ü装，机架侧

5 020-3180-xx 1 Ā式转换套þÿÿ选ÖþĀ

未显示ÿ

A0 1 X美电源插头ÿ115 V，60 HzĀ
A1 1 欧洲通用电源插头ÿ220 V，50 HzĀ
A2 1 英ÿ电源插头ÿ240 V，50 HzĀ
A3 1 澳大利Þ电源插头ÿ240 V，50 HzĀ
A5 1 瑞士电源插头ÿ220 V，50 HzĀ
A6 1 日本电源插头 (100 V, 50/60 Hz)
A10 1 中ÿ电源插头 (50 Hz)
A11 1 sþ电源插头 (50 Hz)
A12 1 巴西电源插头 (60 Hz)

 维æ
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EMC1Ü全和ÿ境合规性

合规性信o

m部V列û仪器遵循的 EMCÿ电磁|容性Ā1Ü全和ÿ境标准2本产品仅供_`人员和Ø过ÿ¯的人员使用Ā
O得在家中或供儿童使用2

如果üñQ合规性信o`在疑þ，ÿñ联系ñQ地址ÿ

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC 合规性

EU EMC 指ð
符合 Directive 2014/30/EU 有关电磁|容性的要求2已证明符合:欧洲r\体}ç;中�列的ñQ�术规格ÿ

EN 61326-11EN 61326-2-1. 测量1ç制和实验室用电气¿备的 EMC 要求2  1 2 3 4

■ CISPR 112�射和传ü�射量，组 1，A 类

■ IEC 61000-4-22ü静电�电的ù~p能力

■ IEC 61000-4-32ü射频电磁场的ù~p能力  5

■ IEC 61000-4-42ü电快�瞬a/突发性的ù~p能力

■ IEC 61000-4-52ü电源线电涌的ù~p能力

■ IEC 61000-4-62ü传ü射频的ù~p能力

■ IEC 61000-4-112ü电压骤降和中断的ù~p能力

EN 61000-3-2. 交流电源线谐波�射

EN 61000-3-3. 电压ÙW1波ú和闪Ù

1 本产品仅在非居民|内使用2在居民|内使用ÿ能 成电磁~p2
2 `ï¿备P测试ü象â接时，ÿ能产生超过m标准要求的�射ÿ别2
3 测试ü线和/或测试探头由于电子~p耦合而发生â接时，¿备ÿ能无法满足�列�用标准的ù~p能力要求2~了将电磁~p的影响降到Ā
P，需Ā小W信÷无屏蔽部VP关联返回ü线之间的ÿ路面ÿ，\时尽量让ü线à离电磁~p源2将未屏蔽的测试ü线缠绕在一起是减小ÿ

路面ÿ的有效方法2探头方面，需要使接地回路ü线的长þ尽ÿ能得短，并靠à探头�体2~了Ā有效地达到à一目的，一ß探头配备了Ö

þ探头端部�配器2在一W情况Q，都Þ遵Û�用探头或ü线的�有Ü全说明2
4 ~确保符合P面列û的 EMC 标准，Þ使用在电缆æ套和â接器外壳间包�P阻ùâ接的高°量屏蔽接口电缆2
5 10 mV/格ó 1 V/格ÿ`仪器Ø到 IEC 61000-4-3 测试�定义的电磁场和信÷的影响时，允许 <=0.1 格波形O移或峰-峰值噪声增à <=0.2 格2
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EMC 合规性
随<�术规格=表中指明的产品使用时，符合 2014/30/EU 指ð中有关电磁|容性的要求2请参阅�ü指û的
产品发_的 EMC �术规格2随w他产品使用时，ÿ能O符合ï指ð的要求2

澳大利Þ/新西q一ô性声明 – EMC
�据 ACMA，符合:无线电通信法;有关 EMC 规定的ñQ标准ÿ

■ EN 61326-1 和 EN 61326-2-12�射和传ü�射量，组 1，A 类2

Ü全标准

本部V列û了产品遵循的Ü全标准及w他Ü全合规性信o2

欧盟一ô性声明 - P电压
经证明符合:欧盟官方}ç;中�列的ñQ�术规格ÿ

P电压指ð 2014/35/EU2

■ EN 61010-12 测量1ç制和实验室用电气¿备Ü全要求 – 第 1 部Vÿ总体要求2

■ EN 61010-2-0302 测量1ç制和实验室用电气¿备Ü全要求 – 第 2-030 部Vÿ关于测试和测量电路的特殊
要求2

美ÿÿ家认ÿ的测试实验室列表

■ UL 61010-12 测量1ç制和实验室用电气¿备Ü全要求 – 第 1 部Vÿ总体要求2

■ UL 61010-2-0302 测量1ç制和实验室用电气¿备Ü全要求 – 第 2-030 部Vÿ关于测试和测量电路的特殊
要求2

à拿大认证

■ CAN/CSA-C22.2 No. 61010-12 测量1ç制和实验室用电气¿备Ü全要求 – 第 1 部Vÿ总体要求2

■ CAN/CSA-C22.2 No. 61010-2-0302 测量1ç制和实验室用电气¿备Ü全要求 – 第 2-030 部Vÿ关于测试和
测量电路的特殊要求2

w他合规性

■ IEC 61010-12 测量1ç制和实验室用电气¿备Ü全要求 – 第 1 部Vÿ总体要求2

■ IEC 61010-2-0302 测量1ç制和实验室用电气¿备Ü全要求 – 第 2-030 部Vÿ关于测试和测量电路的特殊
要求2

¿备类型

测试和测量¿备2

Ü全ÿ别

I ÿ - 接地产品2

EMC1Ü全和ÿ境合规性  
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m÷þ说明

ü产品周围和产品内部ÿ境中ÿ能ûĀ的m÷的一种量þ2通常认~产品的内部ÿ境P外部ÿ境相\2产
品只Þï在w规定ÿ境中使用2

■ m÷þ 12无m÷或仅发生~燥1非ü电性m÷2m类别产品通常予ñ封装1密封或被置于~净的�间
中2

■ m÷þ 22通常只发生~燥1非ü电性m÷2偶尔会发生由凝结引起的临时传ü2y型的Þ}室/家庭ÿ
境属于à种情况2只有`产品处于非使用状a时，才会发生临时凝结2

■ m÷þ 32ü电性m÷，或~燥1非ü电性m÷，由于凝结^者会Ù成ü电性m÷2m类场�~温þ和
湿þOØç制的建有遮盖¿施的场�2m类|域OØ·Z1雨水或自然风的直接侵害2

■ m÷þ 42通过传ü性的尘埃1雨水或雪产生永久性ÿü性的m÷2户外场�通常属于à种情况2

m÷þ评ÿ

m÷þ 2ÿ如 IEC 61010-1 中定义Ā2注ÿ仅�合在室内的~燥场�使用2

IP �定值
IP20ÿ如 IEC 60529 中定义Ā2

测量和过压类别说明

本产品P的测量端子ÿ能�合测量ñQ一种或多种类别的^电电压ÿ请参阅产品和手Ý中标示的x体�定

值Ā2

■ 测量类别 II2用于在PP电压Ü装直接相â的电路P执行的测量2

■ 测量类别 III2用于在建筑Ü装中执行的测量2

■ 测量类别 IV2用于在P电压Ü装电源处执行的测量2

NOTE. 仅^电电源电路x有过压类别�定值2仅测量电路x有测量类别�定值2产品中的w他电路Ox有w
中任何一种�定值2

�线过压类别�定值

过压类别 IIÿ如 IEC 61010-1 中的定义Ā

ÿ境合规性

本部V提供有关产品üÿ境影响的信o2

有害物°限制

符合 RoHS2 指ð 2011/65/EU2

产品ç废处理

回收仪器或器þ时，请遵ÛQ面的规程ÿ

¿备回收. 生产本¿备需要提×和使用自然资源2如果ü本产品的ç废处理O`，则ï¿备中包�的某ß物
°ÿ能会üÿ境或人体健康有害2~避免将有害物°释�到ÿ境中，并减少ü自然资源的使用，建°采用�

`的方法回收本产品，ñ确保大部V材料ÿñ得到p`的重复使用或回收2

 EMC1Ü全和ÿ境合规性
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m符÷表示ï产品符合欧盟有关废旧电子和电气¿备 (WEEE) ñ及电l的 2012/19/EU 和 2006/66/
EC ÷指ð�规定的相关要求2有关回收选ù的信o，请登录泰克网站 (www.tek.com/
productrecycling) 查看2

电l回收

本产品装有小型�金属纽扣电l2如果电量用尽，请�据`地�府法规l确处理或回收m电l2

高氯酸ö材料. m产品包�一个或多个 CR 型�电l2按照à州规定，CR �电l被_类~高氯酸ö材料，需
要特殊处理2ð情参阅 www.dtsc.ca.gov/hazardouswaste/perchlorate2

ß输电l

本¿备的小型纽扣�原电l的�金属�量O超过 1 g/电l，制 商已经表示m类电l满足联合ÿ:试验和标
准手Ý;第 3 部V第 38.3 节中的�用要求2在采用任一ß输方式重新ß输产品前，请咨询�ß}ø确定哪ß
�电lß输要求�用于您的配置，包括重新包装和重新½标

EMC1Ü全和ÿ境合规性  
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A
ACQ 采集状a LED, 7
AFG OUTÿ^面板Ā, 9
AUX OUTÿ^面板Ā, 9
Aux Trig 触发输入, 7
Ü全电缆�, 9

B
标配Öþ, 1

D
DVI 视频输ûÿ^面板Ā, 9
打开或关ý电源, 4
打开或关ý仪器, 4
电缆�, 9
电源à机模式, 4
电源线, 19
电源线â接器ÿ^面板Ā, 9
电源要求, 1, 2
断开仪器的交流电源, 4

E
e*Scope, 15

F
FlexChannel 输入通道, 7

G
ý作
海拔高þ范围, 1, 2
湿þ范围, 1, 2
温þ范围, 1, 2

ý作ß率要求, 1, 2
固þ，如何更新, 11, 12

H
^面板

AFG Out, 9
AUX Out, 9
DVI 视频输û, 9
LAN 端口 (RJ-45), 9
USB ¿备端口, 9
USB �ç端口, 9
VGA 视频输û, 9
Ü全电缆�, 9
电缆�, 9
电源线, 9
视频输û, 9
显示端口视频输û, 9
ñ太网端口 (RJ-45), 9

^面板â接, 9
ÿ境要求, 1, 2

K
开机自检结果, 5
ÿ更换部þ, 19

L
LAN 端口ÿ^面板Ā, 9
LAN 状a LED, 7
LAN，â接到, 15
â接�定电缆, 4
â接探头, 5
â接网þ, 15

Q
前面板çþ, 7

R
Ref In, 9
Ref Inÿ^面板Ā, 9
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如何
补偿 TPP0500B1TPP1000 探头, 13
更新固þ, 11, 12
检查开机自检结果, 5
â接探头, 5
â接网þ, 15
¿置时|, 11
¿置时钟格式ÿ12/24 小时制Ā, 11
Q载和Ü装固þ, 11, 12
à程Àþ示波器ÿÐ WebĀ, 15
ß行信÷路ß补偿 (SPC), 12

如何补偿 TPP0500B1TPP1000 探头, 13

S
SPCÿ信÷路ß补偿Ā, 12
¿置
时|, 11
时钟格式ÿ12/24 小时制Ā, 11

时|，如何¿置, 11
时钟格式ÿ12/24 小时制Ā，如何¿置, 11
视频输ûÿ^面板Ā, 9
输入信÷电�要求, 2
�定到ý作Ā或机架, 4

T
探头，â接, 5
探头补偿ÿTPP0500B1TPP1000Ā, 13
探头补偿â接器, 7

U
USB ¿备端口ÿ^面板Ā, 9
USB �ç端口ÿ^面板Ā, 9

V
VGA 视频输ûÿ^面板Ā, 9

W
网þ，â接到, 15
维æ
ÿ更换部þ, 19

X
显示端口视频输ûÿ^面板Ā, 9
信÷输入电�, 2

Y
要求
电源, 1, 2
海拔高þ, 1, 2
ÿ境, 1, 2
湿þ, 1, 2
温þ, 1, 2
信÷输入, 2

ñ太网，â接到, 15
ñ太网端口ÿ^面板Ā, 9
à程Àþ (e*Scope), 15
à程ÀþÿĀ于 WebĀ, 15
ß行信÷路ß补偿, 12

Z
自ú探头补偿ÿTPP0500B1TPP1000Ā, 13
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